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FlashPro Express

FlashPro Express is Microsemi’s programming tool designed from the ground up to address secured
programming assurance in production programming house environments. FlashPro Express supports
SmartFusion2, IGLOO2, SmartFusion, IGLOO, ProASIC3, Fusion, and ProASICPLUS devices in the
Windows OS environments and supports SmartFusion2 and IGLOO?2 in the Linux OS environments.

You can install FlashPro Express two ways:
e Integrated with Libero - FlashPro Express is installed automatically when Libero is installed.

FlashPro express is used by Libero to perform the programming tasks, for SmartFusion2 and IGLOO2,
as part of the design flow.

e Stand-Alone - FlashPro Express is also available as a stand alone installation. This mode is primarily
used for production programming or lab programming on machines in which a full version of Libero is
not required. When installed using the stand alone installation, FlashPro Express is joined by the
predecessor product FlashPro.

View the detailed Install Instructions and System Requirements at the Flashpro Express software page:
http://www.microsemi.com/products/fpga-soc/design-resources/programming/flashproexpress#overview

Secure Job Programming

Job programming is the concept of using a single file to program a Microsemi device or chain of Microsemi
devices using encrypted bitstreams.

The single job file contains all of the information necessary to setup FlashPro Express as well as the
encrypted bitstream images for the devices in the job. Once a job file is created it can be handed off
securely to production programming houses or contract engineering facilities to load the Microsemi images
during manufacturing. Job projects can be exported from Libero and imported into stand alone FlashPro
Express providing a clean delineation between design flow and production programming.

Migrating FlashPro Projects to FlashPro Express

Existing FlashPro projects (*.pro) files are now called Job Project files in FlashPro Express. These Job
Projects can be opened with FlashPro Express to take advantage of Linux programming support and the
simplified tool targeted for operators in a production floor environment.

FlashPro projects that were created in single mode will not be supported with this tool. Microsemi
recommends that you convert these projects to chain mode projects. To convert the project to a chain
project, do the following steps:

1. Open the FlashPro project (*.pro) in FlashPro.
2. Locate the loaded STAPL file by one of two methods:

The log will print “STAPL file ‘<stapl_path>" has been loaded successfully.” <stapl_path> is the
location of the STAPL file loaded.

x| Software Versien: 11.5.0.15

A\ |Wazning: i
FL file 'D:\test_projecti\projectDaca\tcpdefault.stp’ has been loaded successfully.

DESIGN : top; CHECKSUM : F673; ALG VERSION : 2

[+ Ty am {Erors J| Warmngs Jinfo ]

Within the Single Device Configuration Window there is a field STAPL_FILE_NAME, which displays the
location of the STAPL file loaded.
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3.

4.

5.

6.

x| Programming file

topdefault.stp ? | Browse...

Modify...

DATE MODIFIED Wed Oct 29 15:-:20:-25 2014
STADPT, FILE NAME D:\teat projectiprojectData\topdefault_at
CERELATOR FlashPro Version: wll_4
DEVICE MZ5050T =
=| |PRACEREE MZ5050T-£g454
9| |paTE 2014/06/18
Z| |STRAEL_VERSICH JESD71
5 IDCODE OF8021CF
o |IDMASE OFFFFFFFE
3 |pEsIew top |
E| |rHECESTIM RRT2
5 4| I I
g
1
£ Chain Parameter... Inspect Device
L+1]
o
E
i

Switch the project to chain mode by one of the two methods:

a.  Press the chain button from the toolbar.

|

b. From the Tools menu, select Mode->Chain Programming.

Load the STAPL file in chain mode by adding a Microsemi device in the chain.
a.  From the File menu, select Configuration->Add Microsemi Devices from Files.

b. Browse to the location of the STAPL file and click Open.

To save the project, from the File menu, select Save Project.
You may now open the project using FlashPro Express.

When moving FlashPro project (*.pro) files to another machine, Microsemi recommends that you archive the
entire project folder, copy it to the new machine, extract it locally, then load the job project within FlashPro
Express. FlashPro Express will only open a job project if a programmer is connected to the machine, at least
one Microsemi device has programmed enabled, and all enabled Microsemi devices have a bitstream file
loaded.

Supported Families - FlashPro Express

FlashPro Express programs all the devices from all the following device families:

SmartFusion2 FPGAs

IGLOO2 FPGAs

SmartFusion FPGAs

IGLOO FPGASs

ProASIC3 FPGAs

Fusion FPGAs

ProASIC PLUS FPGAs - FlashPro Express ONLY; not supported in Libero SOC.

When we specify a family name, we refer to the device family and all its derivatives, unless otherwise
specified. See the table below for a list of supported device families and their derivatives:
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Installing FlashPro Express Software and Hardware

Table 1 - Product Families and Derivatives

Device Family Description
Family Derivatives
SmartFusion2 | N/A Address fundamental requirements for advanced security, high reliability and low power in
critical industrial, military, aviation, communications and medical applications.
IGLOO2 N/A Low-power mixed-signal programmable solution

SmartFusion

SmartFusion

SmartFusion intelligent mixed-signal FPGAs are the only devices that integrate an FPGA,
ARM Cortex-M3, and programmable analog, offering full customization and IP protection.

Eusion N/A Mixed-signal FPGA integrating ProASIC3 FPGA fabric, programmable analog block,
support for ARM® Cortex -M1 soft processors, and flash memory into a monolithic
device.

IGLOO IGLOO The ultra-low-power, programmable solution

IGLOOe Higher density IGLOO FPGAs with six PLLs and additional I/O standards
IGLOO nano The industry’s lowest power, smallest size solution
IGLOO PLUS The low-power FPGA with enhanced 1/O capabilities
ProASIC3 ProASIC3 The low-power, low-cost, FPGA solution
ProASIC3E Higher density ProASIC3 FPGAs with six PLLs and additional I/O standards
ProASIC3 nano | Lowest cost solution with enhanced I/O capabilities
ProASIC3L The FPGA that balances low power, performance, and low cost
Automotive ProASIC3 FPGAs qualified for automotive applications
ProASIC3
Military Military temperature ASPE600L, A3P1000, and A3PE3000L
ProASIC3/EL
RT ProASIC3 Radiation-tolerant RT3PE600L and RT3PE3000L
ProASIC N/A Supported by FlashPro Express ONLY- not supported by Libero SoC.
PLUS

Installing FlashPro Express Software and Hardware

See the FlashPro Express Installation Instructions on the Microsemi website for information on supported
platforms, how to install FlashPro Express software/hardware and relevant system requirements.

View the detailed Install Instructions and System Requirements at the FlashPro Express software page:

http://www.microsemi.com/products/fpga-soc/design-resources/programming/FlashPro#overview
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Getting Started

Starting FlashPro Express

You can start the FlashPro Express software from Programs > Microsemi FlashPro Express vx.x >
FlashPro Express. If you installed the program in a folder other than FlashPro Express, choose that folder
from the Programs menu.
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Starting FlashPro Express

FlashPro Express Interface

The main FlashPro Express Ul consists of a list of programmers and a chain table, as shown in the figure
below. This view displays the programmers connected to the machine, and the devices within the JTAG
chain specified in the job project file (PRO) file, as shown in the figure below.

e Hover over the programmer Info icon to display more information about a programmer.

e Click the Name field to change a programmer name.

e Click the checkbox to enable or disable a programmer.

¢ Right-click a programmer to Ping, Self-Test, Scan, Check Chain or Remove it from the list.

e Additional information about a device and programming file, if loaded, can be viewed by hovering over
the info icon of that device.

e Devices specified as disabled in the job project (*.pro) file are shown disabled and their HighZ value is
displayed in the column header.

e Device/Programmer States:

e IDLE: The devices/programmers are idle and not executing any programming action.
e DISABLED: Devices that are not enabled for programming

e PASSED: The last programming operation passed

¢ FAILED: The last programming operation failed

FlashPro Express User's Guide 9
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E FlashPro Express CivUsers\ptgatDesktoph3&Flashprotderno_10_devices/demo_10_devices.pro EI@
File Edit ‘iew Tools Help
| Refresh/Rescan Programmets
€ First M250507S device @) Second M2SOS0TS device
Praogr armer
<3 TDO TDI 2 <3 TDO DI <2
1 OF s IOLE IDLE ICLE 3
2 @F s IDLE IDLE IDLE
s @F  seem IDLE IDLE IDLE
+ EF sesee IDLE IDLE IDLE
s @@ seome 10LE IDLE IDLE
o 1 2
[PrOGRAM -
Log B X
€3 Errors 4, Wwarnings i Info
progranmer 'S4U7AT ¢ Flashrrod N
programmer 'S4093' : FlashProd
programmer '83998' @ FlashProd
programmer 'S62533' : FlashProd
programmwer '87147' ;@ FlashProd
programmer 'S6215' @ FlashProd
programmer '87186' @ FlashProd
programmer '854021' @ FlashProd
Opened 'C:\Users‘ptga\DesktophSiFlashprotdemo 10_dewviceshdemo_10_devices.pro' -

Figure 1 - FlashPro Express Programmers and Chain Table

Load a Job Project

To get started in FlashPro Express you must load a job project (*.pro file). To do so, from the File menu
choose Load Job Project. A job project will open if:

e Atleast 1 programmer is connected
e Atleast 1 Microsemi device is enabled for programming
e Any enabled Microsemi device for programming must have a bitstream file loaded

Note: FlashPro projects (*.pro) created in single chain mode are not supported with this tool. You must
create a chain mode project with the existing programming files within FlashPro prior to using
FlashPro Express.

To open a project:
1. From the File menu, choose Load Job Project. The Open Project dialog box appears.

2. Find your project file or type in your project file name in the File name field.
3. Click Open.

10 FlashPro Express User's Guide
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Saving a Job Project

EE FlashPro Express Q@@
[Z1=W Edit View Tools Help

rogramming Jobs

Recent Projects List

& Microsemi

= & x
(2] Messages | €Y Emors 1) Wamings i) Info

Checking for software updates...
A e .

Figure 2 - FlashPro Express Launch Screen

Saving a Job Project

Click the Save button on the toolbar, or from the File menu choose Save Job Project to save your project.

Parallel Programming with FlashPro5/4/3/3X

Parallel programming enables you to program multiple Microsemi devices in parallel with multiple
programmers. In parallel programming, all targeted devices are programmed with the same programming
file (STAPL). The targeted device or chain configuration that is connected to each programmer must be
identical.

The FlashPro Express software together with the FlashPro5/4/3/3X programmers supports parallel
programming via a USB port. You can connect up to sixteen FlashPro5/4/3/3X's to a PC via a USB v1.1 or a
USB v2.0 port. FlashPro5/4/3/3X requires a self-powered hub.

Connecting FlashPro5/4/3/3X (a USB v2.0 enabled programmer) to USB v1.1 port increases device
programming time due to a slow data transfer rate on the USB v1.1 port in comparison to a USB v2.0 port.

Note: FlashPro (USB/LPT1) or FlashPro Lite programmers do not support parallel programming.

The following figure illustrates how you can connect a FlashPro5/4/3/3X programmer for parallel
programming.
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Figure 3 - Connecting a FlashPro5/4/3/3X Programmer

An independent thread processes the STAPL file during parallel programming. In an Microsemi test, parallel
programming is approximately five times faster than programming 16 devices sequentially.

Note: Microsemi has tested Belkin PCI-USB cards and hubs. We have found that parallel programming
works best with the vendor's latest driver installed and with the matching hubs.

Chain Programming Tutorial

This tutorial demonstrates how to use FlashPro Express to program a multi-device, multi-programmer chain.
This tutorial uses the production programming flow that exports a programming job from Libero SoC, which
includes chain configuration, programmer settings, and bitstream files for programming, and creates a job
project from a programming job.

The figure below shows the chain used in this tutorial. M2S050T is device 1 and A3P250 is device 3. Device
1 is the first device to be programmed in the chain and device 2 is the last; device 3 is disabled and will not
be programmed.

12
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Chain Programming Tutorial

[34 FlashPro Express CAFPexpress_Tutorial\FPexpress_projectitest/test.pro
File Edit View Tools Help

{Reﬁeshfkescan Programmers |
(3 ] mzsosor ) awEIs0 A3PZS0
Programimer
@Too  TOIG ST TOIG S TDO HighZ OFF TOI G
1 @ oesw IDLE IDLE IDLE DISABLED
z BN smm IDLE I0LE IDLE DISABLED

Figure 4 - Chain Programming Devices
To program a chain:
1. From the File menu choose Create Job Project from Programming Job.

2. Click Browse to load a Programming Job File, and specify your FlashPro Express job project
location. Click OK to continue, as shown in the figure below.

[i4 Create Job Project fram Programming lob @

Programming job file:
Ciilif\FPexpress_TutoriallLibero_project\M25050T-FGE96 designer|test|expartitest. job Browse. ..
FlashPro Exprass job project name:
kest
FlashPro Express job project location:

C:\lij\FPexpress_Tuborial\FPexpress_project Browse. ..

_ Heb [ ok ][ coxel |

Figure 5 - Create Job Project from Programming Job

FlashPro Express displays your Job Project and programmers, as shown in the figure below. The
Device/Programmer states are:

e IDLE: The devices/programmers are idle and not executing any programming action
o DISABLED: Devices that are not enabled for programming.

e PASSED: The last programming operation passed

e FAILED: The last programming operation failed

FlashPro Express User's Guide 13
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[Z3 FlashPro Express Ca\lij\FPexpress_Tutorial\FPexpress_projectitestitest.pro

=3 o
File Edit View Tools Help
_Reﬁemmescmﬁwms_
(i) msosoT € awEls0 ) AP250
Programmer
@T0  TOIGQ GTD0 DI (O TDO HighZ Off TDI G
1 @Y e | D DE | | mE | | oS |
2 @W osse2 IDLE IDLE | IDLE | DISABLED
PROGRAM |
IDLE
RUN ] |
Log

(o) @ rors s oo @

Software Version: 11.4.0.101

STAPL file 'C:\1ij\FPexpress_Tutorial\FPexpress_project\teat\M25050T_ tesct_M25050T.scp’' has been loaded
succesafully.

DESIGN : test; CHECKSUM : 3A67; ALG VERSION : 2

Figure 6 - FlashPro Express with Loaded Job Project

See the Export Programming Job topic for information on how to generate a Programming Job file.
3.

Click the Refresh/Rescan button if your programmer is not listed. Hover your mouse over the Info

icon to view device info. If a device is Disabled for programming the HighZ status appears in the GUI,
as shown in the figure above.

Set the Programming Action in the dropdown menu to PROGRAM, as shown in the figure below.

|PROGRAM - |
DEVICE_INFO
ENC_DATA_AUTHEMTICATION
ERASE
|READ_IDCODE
1 VERIFY

Figure 7 - Programming Action Set to PROGRAM

Click RUN. Detailed individual programmer and device status information appears in the Programmer

List. Your programmer status (PASSED or FAILED) appears in the Programmer Status Bar, as shown
in the figure below.

Hover your mouse over the Programmer Status Bar to display information on the programmers.
Hover over the FAILED status to list all programmers that failed programming.

Hover over the PASSED status to list all the programmers that programmed successfully.
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Creating a Job Project from a Programming Job

12 FlashPro Express Clij\FPexpress_TutoriaNFPexpress_projectitestitest.pro follo =
File Edit View Tools Help
[RefreﬂlfRﬁcan Programmers ]
M25050T APEL500 A3P250
Programmer o 0 o
QT00 TDIO STo0 TGS $TDO HighZ Off TDI O
L Ou e IEEIN EEN SN oo
2 09 w (N | o o o
[DEVICE—NO v} __
Log & X
(= vessoms) @ Erors iy Warings @ Info
P o e
Chain Programming Finished: Mon Jun 09 10:02:13 2014 (Elapsed time 00:00:00) =
o-0-0-0-0-0 | 3

Figure 8 - Chain Programming Complete
Read the Log for Messages, Errors, Warnings and Info generated during programming.

Creating a Job Project from a Programming Job

Once you are ready to hand off your design for production you can create a job project. To do so:

1. InLibero SoC run Export Programming Job to create a container that will be used to transfer
programming configuration information, including programming files, to the production programming

tool FlashPro Express.

FlashPro Express User's Guide

15



NOTE: Links and cross-references in this PDF file may point to external files and generate an error

. . when clicked. View the online help included with software to enable all linked content.
& Microsemi
# | Export Programming lob |
Programming job file name:
sd1_M5S

Existing programming job files:

[B sdimssjob

Selected Security options (modify via Configure Security tool)
Encrypt bitstream with default key, No User keys and Security Policies are enabled.

Design bitstream file to be inchuded in the programming job
Bitstream components

File to program at trusted Facility V] Fabric  [¥] envi

Configured device chain with bitstream files and programmer settings vill be inchuded in the programming job.

[ _res (o J[ comel ]

Figure 9 - Export Programming Job

1. In FlashPro Express, from the File menu choose Create Job Project From a Programming Job. You
will be prompted to specify the Programming Job File location that you just exported from Libero and
the location of where to store the FlashPro Express Job Project. The Job Project name automatically
uses the programming job name and cannot be changed. Click OK and a new Job Project will be
created and opened for production programming.

[i4 Create Job Project fram Programming lob @

Programming job file:
Ciilif\FPexpress_TutoriallLibero_project\M25050T-FGE96 designer|test|expartitest. job Browse. ..
FlashPro Express job project name:
kest

FlashPro Express job project location:

C:\lij\FPexpress_Tuborial\FPexpress_project Browse. ..

. Help ok || cancel

Figure 10 - Create Job Project Dialog Box
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Introduction

Programming Settings and Operations

Introduction

The FlashPro Express software enables you to connect multiple programmers to your computer. With each
programmer you select, you can connect the programmer, perform a self-test, customize, add, and remove
and analyze the JTAG chain, as shown in the figure below.

EE FlashPro Express Z:\QTFP_testing\pc_pro_FPim2s050_896fbga_fabim2s050_896fbga_fab.pro

File Edit View Tools Help
RefreshjRescan Programmers
[i] M25050T
Programmer
< TDO T O
1 (O ez ( DLE T
| St B o e ————y P
Self Test
Scan and check chain
Remave
Enable/Disable
PROGRAM v
Log & x
(&) Messages | @Y Errors 4\ Warnings i) Info
STAPL file 'Z:\QTFP_testing\pc_pro_FP\uZs050_896fbga_fab\projectData\sdl.stp' has been loaded successfully. al
DESIGN : sdl; CHECKSUM : 9EDF; ALG_WERSION : 2
Driver : 3.0.0 build 1
programmer '87272' : FlashPro4
Swarning: The prograuser with id '08051' in the project file ot be detected and
Opened 'Z:/QTFP_testing/pc_pro_FP/mn2s050_896fbyga_fab/m2s050_896fbya_fab.pro' v

Figure 11 - FlashPro Express Right-Click Menu

Programmer Settings

The Programmer Settings dialog box includes setting options for FlashPro5/4/3/3X, FlashPro Lite and
FlashPro.

Note: You can set the TCK setting in the PDB/STAPL file by selecting the TCK frequency in the
Programmer Settings dialog box.

Limitation of the TCK frequency for the selected programmer:
e FlashPro supports 1-4 MHz
e FlashPro Lite is limited to 1, 2, or 4 MHz only.
e FlashPro 4/3/3X supports 1-64 MHz.
e FlashPro5 supports 1-10 MHz
Limitation of the TCK frequency for the target device:
e |GLOO, ProASIC3, and Fusion — 10MHz to 20MHz
e ProASICPLUS and ProASIC — 10 MHz.

During execution, the frequency set by the FREQUENCY statement in the PDB/STAPL file will override the
TCK frequency setting selected by you in the Programmer Settings dialog box unless the Force TCK
Frequency checkbox is selected.

FlashPro Express User's Guide 17
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To set your programmer settings:

1. From the Tools menu, choose Programmer Settings.The Programmer Settings dialog box appears
(as shown in the figure below).

i N
E Programmer Settings @

| FlashPro | FlashProlite | FlashPro3 | FlashPro4 | FlashPros

[V] set Vpump
TCK Mode

@) Free running dock Discrete dockin

] Force TCK Frequency

Set Defaults

[ hHep (o ][ conce |

Figure 12 - Programmer Settings Dialog Box for FlashPro Express

2. Click a programmer tab and check the appropriate settings for your programmer.
3. Click OK.

FlashPro Programmer Settings

Choose your programmer settings for FlashPro (see figure above). If you choose to add the Force TCK
Frequency, select the appropriate MHz frequency. After you have made your selection(s), click OK.

Default Settings

e The Vpp, Vpn, Vdd(l), and Vddp options are checked (Vddp is set to 2.5V) to instruct the FlashPro
Express programmer(s) to supply Vpp, Vpn, Vdd(l) and Vddp.

e The Drive TRST option is unchecked to instruct the FlashPro Express programmer(s) NOT to drive the
TRST pin.

e The Force TCK Frequency option is unchecked to instruct FlashPro Express to use the TCK frequency
specified by the Frequency statement in the STAPL file(s).

FlashPro Lite Programmer Settings

If you choose to add the Force TCK Frequency, select the appropriate MHz frequency. After you have made
your selection(s), click OK.

Default Settings

e The Vpp and Vpn options are checked to instruct the FlashPro Express Lite programmer(s) to supply
Vpp and Vpn.

18 FlashPro Express User's Guide
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Ping Programmers

e The Drive TRST option is unchecked to instruct the FlashPro Express Lite programmer(s) NOT to
drive the TRST pin.

e The Force TCK Frequency option is unchecked to instruct the FlashPro Express Lite to use the TCK
frequency specified by the Frequency statement in the STAPL file(s).

FlashPro5/4/3/3X Programmer Settings

For FlashPro 3, you have the option of choosing the Set Vpump setting or the Force TCK Frequency. If you
choose the Force TCK Frequency, select the appropriate MHz frequency. For FlashPro4/3X settings, you
have the option of switching the TCK mode between Free running clock and Discrete clocking. After you
have made your selections(s), click OK.

Default Settings

e The Vpump option is checked to instruct the FlashPro5/4/3X programmer(s) to supply Vpump to the
device.

e The Force TCK Frequency option is unchecked to instruct the FlashPro5/4/3X to use the TCK
frequency specified by the Frequency statement in the PDB/STAPL file(s).

e FlashPro5/4/3X default TCK mode setting is Free running clock

TCK Setting (ForceTCK Frequency)

If Force TCK Frequency is checked (in the Programmer Setting) then the selected TCK value is set for
the programmer and the Frequency statement in the PDB/STAPL file is ignored.

Note: FlashPro Lite RevA supports only 4MHz on TCK.

Default TCK frequency

When the PDB/STAPL file or Chain does not exist, the default TCK frequency is set to 4MHz. In the Single
Device File Programming mode, FlashPro Express will parse through the file and search for the "freq"
keyword and the "MAX_FREQ" Note field, which are expected in all Microsemi flash device files. The
FlashPro Express software uses the lesser value of the two as the default TCK frequency.

In Chain Programming mode, when more than one Microsemi flash device is targeted in the chain, the
FlashPro Express software passes through all of the files and searches for the "freq" keyword and the
"MAX_FREQ" Note field. The FlashPro Express software uses the lesser value of all the TCK frequency
settings and the "MAX_FREQ" Note field values.

Ping Programmers

To ping a programmer(s):
Right-click a programmer and choose Ping.
Note: You can click the Refresh/Rescan for Programmers button to quickly ping new programmers.

Performing a Self-Test

To perform a self-test:
Right-click the programmer you want to self-test and choose Self Test.

Note: You must connect the programmer to the self-test board that comes with your programmer before
performing a self-test.

Note: Self-test is not supported with FlashPro5/4 or FlashPro Lite programmers. These programmers are
rigorously tested at the factory during production.

Scanning and Checking a Chain

The scan chain operation scans and analyzes the JTAG chain connected to programmer(s) you have
selected and checks that chain scanned matches the chain configured in FlashPro Express.
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To scan a chain:
Right-click the programmer you want to scan and choose Scan and check chain.

Enabling and Disabling Programmers

After loading a job project, you can enable/disable or remove a programmer and can also ping, self-test, run
scan and check chain on any of the connected programmers. These actions are available in the shortcut
menu (right-click) for each of the programmers listed in the programmer column.

Click the checkbox next to a programmer in the Programmer column to enable or disable it. The
programmer is enabled when there is a tick mark in the checkbox and disabled when the checkbox is empty.

Renaming a Programmer

Enter the new programmer name in the Programmer window to rename the programmer. By default, the
programmer name is the same as the programmer ID.

Removing a Programmer

To remove a programmer:
Right-click the programmer and choose Remove.
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Chain Order

Chain Programming

Chain Order

Chain Programming enables you to program several devices at one time. The order of devices in the chain
imported from Job Project must match the physical chain to be programmed.

The TDO for the first device connects to the programmer, and the last device's TDI connects to the
programmer. The devices in the chain go in order from a device's TDI into the next device's TDO, as shown
in the figure below.

EE FlashPro Express Z:\QTFP_testing\pc_pro_FP\chain_sf2_g3_fusion\chain_sf2_g3_fusion.pro

SN Edit View Tools Help
M25050T A3P250 AFS600
Programmer 0 0 0
@10 T3 GO0 TG HT0 ToIG
1 @ 87272 IOLE 1| IDLE | IDLE || | IDLE |
PROGRAM v
Log 8 x
[E]) Messages | € Errors 1}, warnings i Info
STAPL file 'Z:\QTFP_testing\pc_pro FP\chain sf2 g3_fusion\projectData\sdl.stp’' has been loaded successfully. Al
DESIGN : sdl; CHECKSUM : 1D47; ALG_VERSION : 20
Driver : 3.0.0 build L
programmer '87272' : FlashProd
&varning: The programmer with id '08051' in the project file camnot be detected and comnected.
Dpened 'Z:\QTFP_testing\pc_pro_FP\chain_sf2_g3_fusion\chain_sf2_g3_fusion.pro’ |

Figure 13 - Chain Order

Multiple Device Chain Programming

The FlashPro Express software enables direct chain programming without generating a chain STAPL file.
Each device will be programmed in sequential order starting from device 1 to device N. See example below.
For more information about chain order, see the Chain Order help topic.

TDI > Device N > Device N-1 >... > Device 2 > Device 1 > TDO

Device Programming Compatibility

SmartFusion2, IGLOO2, SmartFusion, IGLOO, ProASIC3, Fusion families can be programmed in the same
chain.

Programmer Support

FlashPro5/4/3/3X supports only SmartFusion2, IGLOO2, SmartFusion, IGLOO, ProASIC3, Fusion family
devices. The Vpump on FlashPro5/4/3/3X is designed to support the programming of only one device.
Please make sure that Vpump, Vcc and Vjtag are provided on board for chain programming. Connect the
Vpump to the header as the Flashpro Express software will attempt to check for all external supplies,
including Vpump, to ensure successful programming. There is no limitation to the chain length; however,
ensure that the JTAG signal integrity and the timing are preserved.
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Selecting an Action

FlashPro Express supports the following programming actions:

DEVICE_INFO

ENC_DATA_AUTHENTICATION - encrypted bitstream files for SmartFusion and ProASIC3; bitstream
files for SmartFusion2. If an enabled device for programming does not contain this action in the chain,
then the action will error out.

ERASE
PROGRAM
READ_IDCODE
VERIFY

To configure a programming action:

Select an action from the Programming Action dropdown menu in FlashPro Express, as shown in the figure
below.

|PROGRAM >

DEVICE_INFO

ENC_DATA_AUTHEMTICATION

ERASE

|READ_IDCODE ;
g VERIFY |

Figure 14 - FlashPro Express Programming Actions
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About TCL Commands - FlashPro Express Tcl Command Reference

Tcl Commands - FlashPro Express

About TCL Commands - FlashPro Express Tcl Command

Reference

A Tcl (Tool Command Language) file contains scripts for simple or complex tasks. You can run scripts from
the Windows command line or store and run a series of Tcl commands in a *.tcl batch file. The Tcl
commands supported by FlashPro are listed in the table below.

Note: Tcl commands are case sensitive. However, their arguments are not.

Command

Action

close_project

Closes the FlashPro project

configure_flashpro prg

Changes FlashPro programmer settings

configure flashpro3 prg

Changes FlashPro 3 programmer settings

configure flashpro4 prg

Changes FlashPro 4 programmer settings

configure flashpro5 prg

Changes FlashPro 5 programmer settings

configure_flashproLite prg

Changes FlashPro Lite programmer settings

create job

Create a job in FlashPro Express

dump_tcl_support

Unloads the list of supported FlashPro Tcl commands

enable_serialization

Enables or disables serialization programming.

open_project Opens a FlashPro project
ing_pr Pings one or more programmers

refresh_prg_list

Refreshes the programmer list

remove_pr

Removes the programmer from the programmer list

run_selected actions

Runs the selected action on the specified programmer and
returns the exit code from the action

save_log

Saves the log file

save_project

Saves the FlashPro project

scan_chain_prg

Runs scan chain on a programmer

select_serial_range

Selects the range of indexes to program.

self_test prg Runs Self-Test on a programmer
set_prg_name Changes the user name of a programmer
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Command Action

set_programming _action Selects the action for a device

set_serialization_log_file Sets the path and name of the serialization log file.

Running Tcl Scripts from within FlashPro Express

Instead of running scripts from the command line, you can use FlashPro Express's Execute Script dialog box
to run a script.

To execute a Tcl script file within FlashPro Express:
1. From the File menu, choose Execute Script to display the Run Script dialog box.

r ™
E Run Script M

ScriptFile: |

Arguments:

o) Lo

Figure 15 - Run Script Dialog Box

2. Click the Browse button to display the Open dialog box, in which you can navigate to the folder
containing the script file to open. When you click Open, FlashPro Express enters the full path and
script filename into the Run Script dialog box for you.

3. Inthe Arguments box, enter the arguments to pass to your Tcl script. Separate each argument by a
space character. For information about accessing arguments passed to a Tcl script, see

4. Click Run.

Running Tcl Scripts from the Command Line

You can run Tcl scripts from your Windows or Linux command line.

To execute a Tcl script file in the FlashPro Express software from a shell command line:
1. Atthe prompt, type the path to the Microsemi software followed by the word "SCRIPT" and a colon,

and then the name of the script file as follows:

<location of Microsemi software>/bin/FPExpress.exe SCRIPT:<filename>
The example below executes in batch mode the script foo.tcl:
<location of Microsemi software>/bin/FPExpress.exe script:foo.tcl
The example below executes in batch mode the script foo.tcl and exports the log in the file foo.txt:
<location of Microsemi software>/bin/FPExpress.exe script:foo.tcl logfile:foo.txt

The example below executes in batch mode the script foo.tcl, creates a console where the log is
displayed briefly, and exports the log in the file foo.txt:

<location of Microsemi software>/bin/FPExpress.exe script:foo.tcl console_mode:brief
logfile:foo.txt
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Exporting Tcl Scripts from within FlashPro Express

If you leave console_mode unspecified or set it to 'hide’ FlashPro Express executes without a console
window. If you want to leave the console window open you can run the script with the console_mode
parameter set to 'show', as in the following example:

<location of Microsemi software>/bin/FPExpress.exe script:foo.tcl console_mode:show
logfile:foo.txt

2. If you want to pass arguments to the Tcl script from the command line, then use the "SCRIPT_ARGS"
variable as follows:

<location of Microsemi software>/bin/FPExpress.exe SCRIPT:<filename> SCRIPT_ARGS:"paraml
param2 param3'

Arguments passed to a Tcl script can be accessed through the Tcl variables argc and argv. The example
below demonstrates how a Tcl script accesses these arguments:

puts "Script name: $argv0"
puts “Number of arguments: $argc"
set i1 0
foreach arg $argv {
puts "Arg $i : $arg"
incr i
¥
Note: Script names can contain spaces if the script name is protected with double quotes:
FPExpress script:"FPExpress tcl/foo 1.tcl"

Exporting Tcl Scripts from within FlashPro Express

To export a set of Tcl commands from the FlashPro Express history:

1. From the File menu, choose Export Script File.
2. Enter the filename and click Save. The Export Script Options dialog appears (as shown in the figure

below).
34 Export Script @Iﬂ
Script file:  pxported.td ]
Files name formatting

@ Relative file names (relative to the script file location)

Qualified file names (full path; induding directory name)

relp o J[ conce |

p o
Figure 16 - Script Export Options Dialog Box

Check the Include commands from current project only to export commands of the current project
only. You can specify the filename formatting by selecting Relative filenames (relative to the current
directory) or Qualified filenames(absolute path, including the directory name).

4. Click OK.
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close_project

Closes the FlashPro or FlashPro Express project.

close_project

Arguments
None

Supported Families
Al

Exceptions
None

Example
close_project

configure_flashpro_prg

Changes FlashPro programmer settings.

configure_flashpro_prg [-vpp {ON]JOFF}] [-vpn {ON]JOFF}] [-vddl {ON]JOFF}] [-force_vddp
{ON]OFF}] [-vddp {2.5]3-3}] [-drive_trst {ON|OFF}] [-force_freq {ON|OFF}] [-freq {freq}]l

Arguments
-vpp {ON]OFF}
Enables FlashPro programmer to drive VPP. Set to ON to drive VPP.
-vpn {ON|OFF}
Enables FlashPro programmer to drive VPN; set to ON to drive VPN.
-vddl {ON]JOFF}
Enables FlashPro programmer to drive VDDL; set to ON to drive VDDL.
-force_vddp {ON|OFF}
Enables FlashPro programmer to drive VDDP; set to ON to drive VDDP.
-vddp {2.5]3.3}
Sets VDDP to 2.5 or 3.3 volts.
-drive_trst {ON]|OFF}
Enables FlashPro programmer to drive TRST; set to ON to drive TRST.
-force_freq {ON|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families
ProASICPYE, proASIC

Exceptions
None
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configure_flashpro3_prg

Example

The following example enables the FlashPro programmer to drive the VPP, VPN, VDDL, VDDP, sets the
drive voltage to 3.3v, disables the driver for TRST, and does not force the programmer to use the TCK
frequency specified in the software.

configure_flashpro_prg —vpp {ON} —vpn {ON} —vddl {ON} —force_vddp {ON} —vddp {3.3} —
drive_trst {OFF} —force_freq {OFF}

configure_flashpro3_prg

Changes FlashPro3 programmer settings.

configure_flashpro3_prg [-vpump {ON]JOFF}] [-clk_mode {discrete_clk]free_running_clk}] [-
force_freq {ON|OFF}] [-freq {freq}]

Arguments
-vpump {ON|OFF}
Enables FlashPro programmer to drive VPUMP. Set to ON to drive VPUMP.
-clk_mode {discrete_clk]|free_running_clk}
Specifies free running or discrete TCK.
-force_freq {ON]|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

The following example sets the VPUMP option to ON, TCK to free running, and uses the TCK frequency
specified in the programmer file (force_freq is set to OFF):

configure_flashpro3_prg -vpump {ON} -clk _mode {free_running_clk} -force_freq {OFF} -freq
{43
The following example sets VPUMP to ON, TCK to discrete, forces the FlashPro software to use the TCK
frequency specified in the software (-force_freq is set to ON) at a frequency of 2 MHz.

configure_flashpro3 _prg -vpump {ON} -clk_mode {discrete_clk} -force_freq {ON} -freq {2}

configure_flashpro4 prg

Changes FlashPro4 programmer settings.

configure_flashpro4_prg [-vpump {ON]JOFF}] [-clk_mode {discrete_clk]free_running_clk}] [-
force_freq {ON|OFF}] [-freq {freq}]

Arguments
-vpump {ON]|OFF}
Enables FlashPro4 programmer to drive VPUMP. Set to ON to drive VPUMP.
-clk_mode {discrete_clk]|free_running_clk}
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Specifies free running or discrete TCK.
-force_freq {ON|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families
SmartFusion, IGLOO, ProASIC3 and Fusion

Exceptions
None

Example

The following example sets the VPUMP option to ON and uses a free running TCK at a frequency of 4 MHz
(force_freq is set to OFF).

configure_flashpro4_prg -vpump {ON} -clk _mode {free_running_clk} -force_freq {OFF} -freq
{4}
The following example sets the VPUMP option to ON, uses a discrete TCK and sets force_freq to ON at 2
MHz.

configure_flashpro4_prg -vpump {ON} -clk_mode {discrete_clk} -force_freq {ON} -freq {2}

configure_flashpro5 prg

Changes FlashPro5 programmer settings.

configure_flashpro5_prg [-vpump {ON]JOFF}] [-clk_mode {free_running_clk}] [-programming_method
{Jtag | spi_slave}] [-force_freq {ON|OFF}] [-freq { freq}]l

Arguments
-vpump {ON|OFF}
Enables FlashPro5 programmer to drive VPUMP. Set to ON to drive VPUMP.
-clk_mode {free_running_clk}
Specifies free running TCK.
-programming_method {jtag | spi_slave}
Specifies the programming method to use. spi_slave works only with SF2 and IGLOO2. Default is jtag.
-force_freq {ON|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.
Supported Families

RT ProASIC3, SmartFusion, IGLOO, ProASIC3, Fusion, SmartFusion2 and IGLOO2

Exceptions
None
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configure_flashproLite_prg

Example

The following example sets the VPUMP option to ON and uses a free running TCK at a frequency of 4 MHz
(force_freq is set to OFF).

configure_flashpro5 _prg -vpump {ON} -clk_mode {free_running_clk} -force_freq {OFF} -freq

{4}
The following example sets the VPUMP option to ON, uses a free running TCK and sets force_freq to ON at
2 MHz.
configure_flashpro5 _prg -vpump {ON} -clk_mode {free_running_clk} -force_freq {ON} -freq
{2}

configure_flashproLite prg

Changes FlashPro Lite programmer settings.

configure_flashproLite _prg [-vpp {ONJOFF}] [-vpn {ON|OFF}] [-drive_trst {ON|OFF}] [-
force_freq {ON|OFF}] [-freq {freq}]

Arguments
-vpp {ON|OFF}
Enables FlashPro programmer to drive VPP. Set to ON to drive VPP.
-vpn {ON|OFF}
Enables FlashPro programmer to drive VPN; set to ON to drive VPN.
-drive_trst {ON]|OFF}
Enables FlashPro programmer to drive TRST; set to ON to drive TRST.
-force_freq {ON|OFF}

Forces the FlashPro software to use the TCK frequency specified by the software rather than the TCK
frequency specified in the programmer file.

-freq {freq}
Specifies the TCK frequency in MHz.

Supported Families
ProASIC™®

Exceptions
None

Example

The following example sets the programmer to drive the VPP, drive VPN, drive the TRST and uses the
frequency set by the programmer file (sets force_freq to OFF):

configure_flashprolite_prg —vpp {ON} —vpn {ON} —drive_trst {ON} —force_freq {OFF}

create_job_project

Creates a Flashpro Express job using the programming job exported from Libero.

create_job_project —job_project_location location —job_file path —overwrite 0|1

Arguments
-job_project_location location
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Specifies the location for your FlashPro Express job project.

-job_file path

Path to the Libero job file that is used as input to create the Flashpro Express job project.
-overwrite 0|1

Set value to 1 to overwrite your existing job project. .

Supported Families
SmartFusion2, IGLOO2

Exceptions
None

Example

The following example creates a job project named test.job in the \fpexpress directory. It does not
overwrite the existing job project.

create_job_project \
-job_project_location {D:\fpexpress} \
-job_Tfile {D:\test\designer\test\export\test.job} —overwrite O\

dump_tcl_support

Unloads the list of supported FlashPro or FlashPro Express Tcl commands.

dump_tcl_support -file {file}

Arguments
-file {file}

Supported Families
All

Exceptions
None

Example

The following example dumps your Tcl commands into the file 'tcldump.tcl’
dump_tcl_support -file {tcldump.tcl}

enable_serialization

This Tcl command enables or disables serialization programming.

enable_serialization —name {device_name} -enable {true|false}

Arguments
-name
Specifies the device name.
-enable
Enables (true) or disables (false) serialization programming.
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open_project

Exceptions
Must be a Microsemi Device

Supported Families
See the_Tcl Commands and Supported Families table for the list of families that support this command.

Example
enable_serialization -name M2S/M2GLOSO{T|S|TS} -enable true

open_project
Opens a FlashPro or FlashPro Express project.

open_project -project {project}

Arguments
-project {project}
Specifies the location and name of the project you wish to open.

Supported Families
All

Exceptions
None

Example

Opens the 'FPPrjl.pro' project from the FPProjectl directory
open_project -project {./FPProjectl/FPPrjl._pro}

ping_prg

Pings one or more programmers.

ping_prg (-name {name})*

Arguments
-name {name}
Specifies the programmer to be pinged. Repeat this argument for multiple programmers.

Supported Families
All

Exceptions
None

Example
The following example pings the programmers 'FP300085' and 'FP30086'.
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ping_prg —name {FP300085} —name {FP300086}

refresh_prg_list

Refreshes the programmer list. This is most often used to have FlashPro or FlashPro Express detect a
programmer that you have just connected.

refresh_prg_list

Arguments
None

Supported Families

All
Exceptions

None
Example

refresh_prg_list
remove_prg

Removes the programmer from the programmer list.

remove_prg (-name {name})*

Arguments
-name {name}*
Specifies the programmer to be removed. You can repeat this argument for multiple programmers.

Supported Families
All

Exceptions
None

Example

The following example removes the programmer '03178' from the programmer list:
remove_prg (name {03178})*

run_selected_actions

Runs the selected action on the specified programmer and returns the exit code from the action. If no
programmer name is specified, the action is run on all connected programmers. Only one exit code is
returned, so return code cannot be used when action is run on more than one programmer. A
programming file must be loaded.

run_selected_actions [(-name {name})*]
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save_log

Arguments
-name {name}

Optional argument that specifies the programmer name. You can repeat this argument for multiple
programmers.

Supported Families

All
Exceptions
None
Example
The following example runs the selected actionS on the programmers 'FP30085' and 'FP30086'".
run_selected_actions —name {FP300085} —name {FP300086%}
Example using return code:
if {[catch {run_selected_actions} return_val]} {puts "Error running Action"} else {puts
"exit code $return_val"}
Example returning exit code to the command line (returns exit 99 on script failure, otherwise returns exit
code from selected action):
if {[catch {run_selected_actions} return_val]}{exit 99} else {exit $return_val}
save log

Saves the log file.

save_log -file {fTile}

Arguments
—file {File}
Specifies the log filename.

Supported Families
All

Exceptions
None

Example

The following example saves the log file with the name 'my_logfilel.log":
save_log -file {my_logfilel.log}

save_project

Saves the FlashPro or FlashPro Express project.

save_project

Arguments
None
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Supported Families
All

Exceptions
None

Example
save_project

scan_chain_prg
In single mode, this command runs scan chain on a programmer.
In chain mode, this command runs scan and check chain on a programmer if devices have been added in
the grid.

scan_chain_prg [(-name {name})+]

Arguments
-name {name}
Specifies the programmer name.

Supported Families
All

Exceptions
None

Example

The following example runs scan chain on a single programmer (single mode) named '21428":
scan_chain_prg -name {21428}

select_serial_range

This Tcl command selects the range of indexes to program.

select_serial_range -name device _name -from data start_index_to program -to_data
end_index_to_program

Arguments
-name
Specifies the device name.
-from_data
Specifies the start index to program.
-to_data
Specifies the end index.

Supported Families
See the_Tcl Commands and Supported Families table for the list of families that support this command.
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self_test_prg

Exceptions
Must be a Microsemi Device

Example
select_serial_range -name M2S/M2GLOSO{T|S|TS} -from data 3 -to_data 5

self test prg

Runs Self-Test on a programmer.

self_test_prg (-name {name})*

Arguments
-name {name}
Specifies the programmer name. You can repeat this argument for multiple programmers.

Supported Families
All

Exceptions
None

Example

The following examples runs the self test on the programmer '30175":
self_test_prg (-name {30175})*

set_prg_name

Changes the user name of a programmer.

set_prg_name -name {name} -new_name {new_name}

Arguments
-name {name}
Identifies the old programmer name.
-new_name {new_name}
Specifies the new programmer name.

Supported Families
All devices supported by FlashPro.

Exceptions
None

Example

The following example changes the name of the programmer 'FP300086' to 'FP3Prg2":
set_prg_name —name {FP300086} —new_name {FP3Prg2}
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set_programming_action

Selects the action for a device. The device name parameter must be specified only in chain programming
mode. A programming file must be loaded. The device must be a Microsemidevice.

set_programming_action [-name {name}] -action {action}

Arguments
-name {name}
Specifies the device name.
-action {action}
Specifies the action.

Supported Families
SmartFusion, IGLOO, ProASIC3, Fusion

Exceptions
Must be a Microsemi device

Example
The following example sets the programming action in single programming mode:
set_programming_action —action {PROGRAM}

And in chain programming mode:
set_programming_action —name {MyDevicel} —action {ERASE}

set_programming_file

Sets the programming file for a device. Either the file orthe no_file flag must be specified. A
programming file must be loaded. The device must be a Microsemi device .

set_programming_Ffile [-name {name}] [-file {file}] [-no_file { }]

Arguments
-name {name}
Specifies the device name. This argument must be specified only in chain programming mode.
—file {File}
Specifies the programming file.
-no_File
Specifies to unload the current programming file.

Supported Families
SmartFusion, IGLOO, ProASIC3, Fusion

Exceptions
Must be a Microsemi device.

Examples
In single programming mode:
set_programming_file —file {e:/design/pdb/TopA3P250.pdb}
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set_serialization_log_file

In chain programming mode:
set_programming_file —name {MyDevice2} —file {e:/design/pdb/TopA3P250.pdb}
set_programming_file —name {MyDevicel} —no_file

set_serialization_log_file

This Tcl command sets the path and name of the serialization log file.

set_serialization_log_file -file {log_file_path}

Arguments
-file
Specifies the serialization log file path and name

Supported Families
See the_Tcl Commands and Supported Families table for the list of families that support this command.

Exceptions
Must be a Microsemi Device

Example
set_serialization_log_file -file\ {C:/local_z_folder/work/my_serial_log}

SmartFusion2 and IGLOO2 Programming Authentication Error
Codes (AUTHERRCODE)

The table below lists authentication error codes for SmartFusion2 and IGLOO2 devices.

Errors related to programming failures (ERRORCODE errors) are summarized in SmartFusion2 and
IGLOO2 Programming Error Codes.

Table 2 - SmartFusion2 Programming Authentication Error Codes

AUTHERRCODE Description Possible Cause Possible Solution
0 Passed (no error) - -
1,2 Invalid, corrupted Programming file has been corrupted | Regenerate programming file
bitstream
3 Invalid, corrupt File contains an encrypted key that Provide a programming file with an
encryption key does not match the device encryption key that matches that on the
device

File contains user encryption key, but
device has not been programmed with | First program security with master

the user encryption key programming file, then program with user
encryption 1/2 field update programming
Device has user encryption key 1/2 files

enforced and you are attempting to
reprogram security settings You must first ERASE security with the
master security file, then you can reprogram
new security settings
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AUTHERRCODE Description Possible Cause Possible Solution
4 Invalid, corrupted Programming file has been corrupted | Regenerate the programming file
bitstream
5 Back level not Design version is not higher than the | Generate a programming file with a design
satisfied back-level programmed device version higher than the back level version
7 DSN binding DSN specified in programming file Use the correct programming file with a
mismatch does not match the device being DSN that matches the DSN of the target
programmed device being programmed
8 Invalid, corrupted Programming file has been corrupted | Regenerate the programming file
bitstream
9 Insufficient device Device does not support the Generate a programming file with the
capabilities capabilities specified in programming | correct capabilities for the target device
file
10 Incorrect DEVICEID | Incorrect programming file Choose the correct programming file and
select the correct device in chain
Incorrect device in chain
Measure JTAG pins and noise or reflection.
Signal integrity issues on JTAG pins If TRST is left floating, then add pull-up to
pin
Reduce the length of ground connection
11 Unsupported Old programming file Generate programming file with latest
bitstream protocol version of Libero SoC
version
12 Verify not permitted
on this bitstream

SmartFusion2 and IGLOO2 Programming Error Codes
(ERRORCODE)

The table below lists authentication error codes for SmartFusion2 and IGLOO2 devices.

Errors related to authentication failures are summarized in SmartFusion2 and IGLOO2 Programming
Authentication Error Codes.

Table 3 - SmartFusion2 and IGLOO2 Programming Error Codes

ERRORCODE Description
0 Passed (no error)
1 Fabric verification verification failed
2 Device security prevented operation
3 Programming mode not enabled
4 eNVM programing operation failed
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Exit Codes (SmartFusion2 and IGLOO?2)

ERRORCODE

Description

eNVM verify operation failed

Exit Codes (SmartFusion2 and IGLOQO2)

Table 4 - SmartFusion2 and IGLOO2 Exit Codes

Exit
Code

Exit Message

Possible Cause

Possible Solution

0

Passed (no error)

5

Failed to disable
programming mode

Failed to set
programming voltage

Device is busy

Failed to read design
information

Failed to enter
programming mode

Failed to set
programming mode

Failed to read
programming
information

Unstable voltage level

Signal integrity issues on JTAG pins

Monitor related power supplies that cause the
issue during programming; check for transients
outside of Microsemi specifications. See your
device datasheet for more information on transient
specifications.

Monitor JTAG supply pins during programming;
measure JTAG signals for noise or reflection

Failed to verify
IDCODE

Incorrect programming file
Incorrect device in chain

Signal integrity issues on JTAG pins

Choose the correct programming file and select
the correct device in the chain.

Measure JTAG pins and noise for reflection. If
TRST is left floating then add pull-up to pin.

Reduce the length of Ground connection.

10

Authentication Error -
See Authentication
Error Codes

If Authentication Error
is not displayed, see
Error Codes

-18

Digest request from
SPI/JTAG is protected
by user pass key 1

Digest request from SPI/JTAG is
protected by user pass key 1. Lock bit
has been configured in the Debug
Policy within SPM (Security Policy
Manager)

Provide a programming file with a pass key that
matches pass key programmed into the device
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Exit Exit Message Possible Cause Possible Solution
Code
-19 Failed to verify digest | Unstable voltage level Monitor related power supplies that cause the
issue during programming; check for transients
outside of Microsemi specifications. See your
device datasheet for more information on transient
specifications.
Signal integrity issues on JTAG pins Monitor JTAG supply pins during programming;
measure JTAG signals for noise or reflection
-20 FPGA Fabric digest Programming bitstream components do | Use the same programming file that was used to
verification: FAIL not match components programmed program the device.
FPGA Fabric is either erased or the Program the device.
data has been corrupted or tampered
eNVM_0/1 digest Programming bitstream components do | Use the same programming file that was used to
verification: FAIL not match components programmed program the device.
eNVM_0/1 data has been corrupted or
tampered
User security policies Programming bitstream components do | Use the same programming file that was used to
segment digest not match components programmed program the device.
verification: FAIL
User key set 0/1 Programming bitstream components do | Use the same programming file that was used to
segment digest not match components programmed program the device.
verification: FAIL User key set 0/1segment data has been
corrupted or tampered with
Factory row and Programming bitstream components do | Use the same programming file that was used to
factory key segment not match components programmed program the device.
digest verification: FAIL | Factory row and factory key segment
data has been corrupted or tampered
Fabric configuration Programming bitstream components do | Use the same programming file that was used to
segment digest not match components programmed. program the device.
verification: FAIL Fabric configuration segment data has
been corrupted or tampered with
-35 Failed to unlock User Pass key in file does not match device [ Provide a programming file with a pass key that

Pass Key 1

Failed to unlock User
Pass Key 2

matches pass key programmed into the device

SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for
Software v8.6 and Above

The table below lists exit codes for SmartFusion, IGLOO, ProASIC3 and Fusion devices in software v8.6
and ABOVE only. See the Device Exit Codes for pre-v8.6 Software help topic for exit codes for older

versions.

40
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SmartFusion, IGLOO, ProASIC3 and Fusion Device Exit Codes for Software v8.6 and Above

Note: Exit codes with positive integers are reserved for current and future standard EXIT codes of the
STAPL standard. Exit codes with negative integers are reserved for vendor-specific EXIT codes.

Table 5 - Exit Codes for SmartFusion, IGLOO, ProASIC3 and Fusion Family Devices in Software v8.6 and Above

ERROR_CODE Exit Exit Possible Cause Possible Solution
Cod Message
e
0 Passed (no
error)
1 A physical Physical chain configuration has
chain does been altered. Something has
not match become disconnected in the
the expected | chain.
set up from | The specific IR length of non-
the STAPL Microsemi devices may be
file. incorrect.
Also known | The order of the specified chain
as Checking | may be incorrect.
Chain Error.
0x8052 5 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
enter the issue during programming; check for
programmin | Unstable VCC transients outside of Microsemi
g mode. specifications. See your device datasheet
Signal integrity issues on JTAG for more information on transient
pins. specifications.
Device is in FlashFreeze mode Monitor VJTAG during programming;
(ProASICL or IGLOO devices) measure JTAG signals for noise or
reflection.
Older software or programming
file used. Disble the FlashFreeze pin (ProASICL or

IGLOO devices)

Generate STAPL file with the latest

version of Designer/FlashPro.

Use latest version of FlashPro software.
0x801D 6 Failed to Incorrect programming file Choose the correct programming file and
0x8053 verify select the correct device in chain.

IDCODE Incorrect device in chain
Measure JTAG pins and noise or
Signal integrity issues on JTAG reflection. If TRST is left floating then add
pins pull-up to pin.

Reduce the length of ground connection.
0x8005 6 Failed to Programming file generated with | Generate STAPL file with the latest
0x8009 verify AES an older version of software version of Designer/FlashPro. Use latest
0x800B Sec. version of FlashPro software.

Try again at a slower TCK.

Contact Microsemi Technical Support.
0x8008 6 Failed to File is not for M7, but target Check that the target device is M7

FlashPro Express User's Guide

41



http://www.actel.com/techdocs/ds/default.aspx

NOTE: Links and cross-references in this PDF file may point to external files and generate an error

CM- Sefnf when clicked. View the online help included with software to enable all linked content.
ERROR_CODE Exit Exit Possible Cause Possible Solution
Cod Message
e
verify device is M7 enabled.
IDCODE.
Signal integrity issues on JTAG Make sure that the programming file you
Targetis an | pins. generated is for an M7-enabled device.
M7 device
Measure JTAG pins, noise and reflection.
0x800A 6 Failed to Files not for M1, but target device | Check that the target device is M1
verify is M1. enabled.
IDCODE
Signal integrity issues on JTAG Make sure the programming file
Targetis an | pins generated is for an M1-enabled device.
M1 device
Monitor VITAG during programming;
measure JTAG signals for noise or
reflection.
0x800C 6 Failed to File is not for target device. Check the target device; make sure the
verify programming file generated is matches
IDCODE. Signal integrity issues on JTAG the target device.
pins
Core Monitor VJTAG during programming;
enabled measure JTAG signals for noise or
device reflection.
detected
0x800D 6 Failed to File is for M7 but target device is | Check that the target device is not M7
verify not M7. enabled.
IDCODE.
Signal integrity issues on JTAG Make sure that the programming file
The targetis | pins. generated is for non-M7 enabled device.
not M7
device Monitor VIJTAG during programming;
measure JTAG signals for noise or
reflection.
0x800E 6 Failed to File is for M1, but target device is | Check that the target device is not M1
verify not M1. enabled.
IDCODE.
Signal integrity issues on JTAG Make sure that the generated
Target is not | pins programming file is for non-M1 enabled
an M1 device.
device
Monitor VJTAG during programming;
measure JTAG signals for noise or
reflection.
0x8006 6 Failed to File is not for P1, but target device | Check that the target device is P1
verify is a P1 device. enabled.
IDCODE.
Signal integrity issues on JTAG Make sure programming file generated is
Target is not | pins for M1 enabled device.
a P1 device
Monitor VJTAG during programming;
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Cod Message
e
measure JTAG signals for noise or
reflection.
0x801E 6 A3PE600 Contact Microsemi Technical Support
Engineering
Sample
Device
Detected.
This device
is supported
with pre-v8.3
SP1 STAPL
files only
0x8057 8 Failed Erase | Unstable VPUMP voltage level. Monitor related power supplies that cause
Operation. the issue during programming; check for
Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Monitor VJTAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.
0x8058 10 Failed to Monitor related power supplies that cause
program Unstable VPUMP voltage level. the issue during programming; check for
FPGA array transients outside of Microsemi
at row <row | Unstable VCC specifications. See your device datasheet
number>. for more information on transient
Unstable VCC_OSC (Fusion only) | specifications.
Unstable VCC_ROSC voltage Monitor VJTAG during programming;
level (SmartFusion only) measure JTAG signals for noise or
reflection.
Signal integrity issues on JTAG
pins.
0x805D 10 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
Ox805E enable the issue during programming; check for
0x807B FPGA Array. | Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Monitor VJTAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.
0x80 |10 Failed to Monitor related power supplies that cause
95 disable Unstable VPUMP voltage level. the issue during programming; check for
FPGA Array. transients outside of Microsemi
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Cod Message
e
0x80 Unstable VCC specifications. See your device datasheet
96 for more information on transient
0x80 Unstable VCC_OSC (Fusion only) | specifications.
o Unstable VCC_ROSC voltage Monitor VJTAG during programming;
level (SmartFusion only) measure JTAG signals for noise or
reflection.
Signal integrity issues on JTAG
pins.
0x8061 10 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
0x8062 program the issue during programming; check for
FlashROM. | Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Monitor VJTAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.
0x801B 10 Error Unstable VCC_NVM/VCC_0OSC Monitor related power supplies that cause
0x801C programmin | voltage level (Fusion only) the issue during programming; check for
0x806C g Embedded transients outside of Microsemi
0x806D Flash Unstable specifications. See your device datasheet
0x806E Memory VCC_ENVM/VCC_RCOSC for more information on transient
Block voltage level (SmartFusion only) specifications.
(EFMB)
Signal integrity issues on JTAG Monitor VJTAG during programming;
pins measure JTAG signals for noise or
reflection.
NVM corruption is possible when
writing from your design; check Reset signal is not properly tied off in
the NVM status for confirmation. your design.

Inspect device using Device Debug.
0x807D 10 Error Unstable VCC Monitor related power supplies that cause
0x807E programmin the issue during programming; check for

g system init | Unstable VCC_QOSC (Fusion only) [ transients outside of Microsemi
and boot specifications. See your device datasheet
clients Unstable VCC_ROSC voltage for more information on transient
level (SmartFusion only) specifications.
Signal integrity issues on JTAG Monitor VIJTAG during programming;
pins measure JTAG signals for noise or
reflection.

Inspect device using Device Debug.
0x8069 10 Error Programming file generated with | Generate STAPL file with the latest
0x806A programmin | an older version of software version of Designer/FlashPro; use the
0x806B g Embedded latest version of FlashPro software
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Cod Message
e
Flash
Memory Try again at a slower TCK
Block
(EMFB) Inspect device using Device Debug.
Contact Microsemi Technical Support
Ox808E 10 Error Try reprogramming
0x808F programmin
0x8090 g Embedded Contact Microsemi Technical Support
0x8091 Flash
Memory
Block
(EFMB)
0x807F 10 Error Programming file generated with | Generate STAPL file with the latest
0x8080 programmin | an older version of software version of Designer/FlashPro; use the
g system init latest version of FlashPro software
and boot
clients Try again at a slower TCK
Inspect device using Device Debug.
Contact Microsemi Technical Support
0x8059 11 Verify 0 Unstable VPUMP voltage level. Monitor related power supplies that cause
0x805B failed at row the issue during programming; check for
<row Unstable VCC transients outside of Microsemi
number> specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
Verify 1 specifications.
failed at row | Unstable VCC_ROSC voltage
<row level (SmartFusion only) Monitor VIJTAG during programming;
number>. measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.
0x8060 11 Device is programmed with a Run VERIFY_DEVICE_INFO to verify the
Failed to different design. device is programmed with the correct
verify data/design.
FlashROM Unstable VPUMP voltage level.
at row Monitor related power supplies that cause
<FlashROM | Unstable VCC the issue during programming; check for
row transients outside of Microsemi
number>. Unstable VCC_OSC (Fusion only) | specifications. See your device datasheet
for more information on transient
Unstable VCC_ROSC voltage specifications.
level (SmartFusion only)
Monitor VJTAG during programming;
Signal integrity issues on JTAG measure JTAG signals for noise or
pins. reflection.
0x8075 11 Failed to Device is programmed with a Verify the device is programmed with the
0x8076 verify different design. correct data/design.
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Cod Message
e
0x8077 Embedded
Flash Unstable VCC Monitor related power supplies that cause
Memory the issue during programming; check for
Block Unstable VCC_NVM/VCC_OSC transients outside of Microsemi
(EFMB) (Fusion only) specifications. See your device datasheet
for more information on transient
Unstable specifications.
VCC_ENVM/VCC_ROSC voltage
level (SmartFusion only) Measure JTAG pins, and noise or
reflection.
Signal integrity issues on JTAG
pins. Run DEVICE_INFO to confirm if the
target EFMB block is locked with
The EFMB data was modified in FlashLock (pass key). If the target EFMB
your FPGA design after block is locked, then you must unlock it
programming. This could have by erasing the security and then
occurred during standalone verify. | reprogramming with the desired security
settings. After unlocking the target EFMB
The target EFMB is locked with block attempt to rerun the target ACTION.
FlashLock when running ACTION
PROGRAM_NVM_ACTIVE_ARR | Inspect device using Device Debug.
AY or
VERIFY_NVM_ACTIVE_ARRAY.
0x8085 11 Failed to Device is programmed with a Verify the device is programmed with the
0x8086 verify system | different design. correct data/design.
init and boot
clients Unstable VCC Monitor related power supplies that cause
the issue during programming; check for
Unstable VCC_NVM/VCC_OSC transients outside of Microsemi
(Fusion only) specifications. See your device datasheet
for more information on transient
Unstable specifications.
VCC_ENVM/VCC_ROSC voltage
level (SmartFusion only) Measure JTAG pins, and noise or
reflection.
Signal integrity issues on JTAG
pins. Run DEVICE_INFO to confirm if the
target EFMB block is locked with
The EFMB data was modified in FlashLock (pass key). If the target EFMB
your FPGA design after block is locked, then you must unlock it
programming. This could have by erasing the security and then
occurred during standalone verify. | reprogramming with the desired security
settings. After unlocking the target EFMB
The target EFMB is locked with block attempt to rerun the target ACTION.
FlashLock when running ACTION
PROGRAM_NVM_ACTIVE_ARR | Inspect device using Device Debug.
AY or
VERIFY_NVM_ACTIVE_ARRAY.
0x8072 11 Failed to Programming file generated with | Generate STAPL file with the latest
0x8073 verify an older version of software version of Designer/FlashPro; use the
0x8074 Embedded latest version of FlashPro software
Flash
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Cod Message
e
Memory Try again at a slower TCK
Block
(EFMB) Inspect device using Device Debug.
Contact Microsemi Technical Support
0x8083 11 Failed to Programming file generated with | Generate STAPL file with the latest
0x8084 verify system [ an older version of software version of Designer/FlashPro; use the
init and boot latest version of FlashPro software
clients
Try again at a slower TCK
Inspect device using Device Debug.
Contact Microsemi Technical Support
0x8014 11 Failed to Unstable VCC Monitor related power supplies that cause
0x8015 verify the issue during programming; check for
calibration Unstable VCC_NVM/VCC_OSC transients outside of Microsemi
data (Fusion only) specifications. See your device datasheet
for more information on transient
Unstable specifications.
VCC_ENVM/VCC_ROSC voltage
level (SmartFusion only) Monitor VJTAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins
Try reprogramming.
Workaround: Disable optional procedure
CHECK_AND_BACKUP_CALIB
0x805A 11 Verify 0 Device is programmed with a Run VERIFY_DEVICE_INFO to verify the
0x805C failed at row | different design device is programmed with the correct
<row data/design.
number> . Unstable VPUMP voltage level.
Monitor related power supplies that cause
Verify 1 Unstable VCC the issue during programming; check for
failed at row transients outside of Microsemi
<row Unstable VCC_OSC (Fusion only) | specifications. See your device datasheet
number> for more information on transient
Unstable VCC_ROSC voltage specifications.
level (SmartFusion only)
Monitor VIJTAG during programming;
Signal integrity issues on JTAG measure JTAG signals for noise or
pins reflection.
0x8063 14 Failed to Signal integrity issues on JTAG Monitor related power supplies that cause
program pins. the issue during programming; check for
Silicon transients outside of Microsemi
Signature. specifications. See your device datasheet
Failed to for more information on transient
program specifications.
security lock
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Cod Message
e
settings. Monitor VITAG during programming;
measure JTAG signals for noise or
reflection.
0x8068 -18 Failed to Incorrect AES key. Generate a programming file with the
authenticate correct AES key.
the Signal integrity issues on JTAG
encrypted pins. Monitor VIJTAG during programming;
data. measure JTAG signals for noise or
reflection.
Ox805F -20 Failed to Programming file generated with | Generate STAPL file with the latest
verify an older version of software version of Designer/FlashPro; use the
FlashROM latest version of FlashPro software.
at row Device is programmed with a
<FlashROM | different design. Program with the correct data/design.
row
number>. Unstable VPUMP voltage level. Monitor related power supplies that cause
the issue during programming; check for
Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Measure JTAG pins and noise or
reflection.
Signal integrity issues on JTAG
pins.
0x8065 -22 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
program the issue during programming; check for
pass key. Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) [ for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Monitor VJTAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.
0x8066 -23 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
program the issue during programming; check for
AES key. Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Measure JTAG pins and noise or
reflection.
Signal integrity issues on JTAG
pins.
0x8055 -24 | Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Cod Message
e
0x8056 program the issue during programming; check for
UROW. Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Monitor VJTAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins.
Make sure you mounted 0.01pF and
0.33uF caps on Vpump (close to the pin).
0x802A -27 FlashROM File contains no passkey and Provide a programming file with a
Write/Erase | device is secured with a passkey. | passkey that matches the passkey
is protected programmed into the device.
by the Passkey in the file does not
passkey. match device.
A valid
passkey
needs to be
provided.
0x8025 -28 FPGA Array | File contains no passkey and Provide a programming file with a
Write/Erase | device is secured with a passkey. | passkey that matches the passkey
is protected Passkey in the file does not programmed into the device.
by the match device.
passkey.
A valid pass
key needs to
be provided.
0x802B -29 FlashROM File contains no passkey and Provide a programming file with a pass
0x802D Read is device is secured with a passkey. | key that matches the passkey
protected by | Passkey in the file does not match | programmed into the device
passkey. device.
A valid
passkey
needs to be
provided.
0x8024 -30 FPGA Array | File contains no passkey and Provide a programming file with a
0x8026 verification is | device is secured with a passkey. | passkey that matches the passkey
protected by | Passkey in the file does not programmed into the device.
a passkey. match device.
A valid
passkey
needs to be
provided.

-31 Failed to AES key in the file does not match | Provide a programming file with an AES
0x804B verify AES the device. key that matches the AES key
0x8001 key. programmed into the device.
0x8007 Unstable VCC

FlashPro Express User's Guide

49


http://www.actel.com/techdocs/ds/default.aspx

NOTE: Links and cross-references in this PDF file may point to external files and generate an error

CM- Sefnf when clicked. View the online help included with software to enable all linked content.
ERROR_CODE Exit Exit Possible Cause Possible Solution
Cod Message
e
Monitor related power supplies that cause
Unstable VCC_OSC (Fusion only) [ the issue during programming; check for
transients outside of Microsemi
Unstable VCC_ROSC voltage specifications. See your device datasheet
level (SmartFusion only) for more information on transient
specifications.
Unstable JTAG/VPUMP voltage
level. Monitor VIJTAG during programming;
measure JTAG signals for noise or
reflection.
0x8000 -31 Failed to Programming file generated with | Generate STAPL file with the latest
verify AES an older version of software version of Designer/FlashPro; use the
key. latest version of FlashPro software.
Try again at a slower TCK
Contact Microsemi Technical Support
0x8020 -33 FPGA Array | File contains unencrypted array Provide a programming file with an
0x8022 encryption is | data, but device contains AES encrypted FPGA Array data.
0x8028 enforced. A | key.
programmin
g file with
encrypted
FPGA array
data needs
to be
provided.
0x802C -34 FlashROM | File contains unencrypted Provide a programming file with an
0x802F encryption is | FlashROM data, but the device encrypted FlashROM data.
enforced. A | contains an AES key.
programmin
g file with
encrypted
FlashROM
data needs
to be
provided.
Ox801F -35 Failed to Pass key in file does not match Provide a programming file with a pass
0x804A match pass | pass key in device. key that matches the pass key
key. programmed into the device.
0x802E -36 FlashROM File contains encrypted Regenerate security programming file
0x8030 Encryption is | FlashROM, but device encryption | with proper AES key.
not enforced. | is not enforced for FlashROM
Program device security.
Cannot
guarantee Retry programming FlashROM with
valid AES encrypted programming file.
key present
in target
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Cod Message
e
device.
Unable to
proceed with
Encrypted
FlashROM
programmin
g.
0x8021 -37 FPGA Array | File contains encrypted FPGA Regenerate security programming file
0x8023 Encryption is | Array, but the device encryption is | with proper AES key.
0x8027 not enforced. | not enforced for FPGA Array.
0x8029 Program device security.
Cannot
guarantee Retry programming FPGA Array with
valid AES encrypted programming file.
key present
in target
device.
Unable to
proceed with
Encrypted
FPGA Array
verification.
0x8067 -38 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
program the issue during programming; check for
pass key. Unstable VCC transients outside of Microsemi
specifications. See your device datasheet
Unstable VCC_OSC (Fusion only) | for more information on transient
specifications.
Unstable VCC_ROSC voltage
level (SmartFusion only) Measure JTAG pins and noise or
reflection.
Signal integrity issues on JTAG
pins.
Bad device.
0x806F -39 ERROR: 2 Unstable VCC_NVM/VCC_OSC Monitor related power supplies that cause
0x8070 or more voltage (Fusion only) the issue during programming; check for
0x8071 errors found transients outside of Microsemi
0x8081 on this page | Unstable specifications. See your device datasheet
0x8082 VCC_ENVM/VCC_ROSC for more information on transient
0x8089 (SmartFusion only) specifications.
NVM reset signal is floating in Bias NVM reset to a logic state in user
user design design.
2 or more ECC errors found when | Try reprogramming.
reading the eNVM
0x8010 -39 | ERROR: 2 2 or more ECC errors found when | The master calibration data has been
or more reading the master calibration corrupted. Try restoring master
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Cod Message
e
errors found | data calibration from backup, if it exists, by
on this page. running RECOVER_CALIB.
Workaround: Disable optional procedure
CHECK_AND_ BACKUP_CALIB
0x8013 -39 ERROR: 2 2 or more ECC errors found when | Rerun action to attempt to write backup
or more verifying the backup calibration calibration again.
errors found
on this page. Workaround: Disable optional procedure
CHECK_AND_ BACKUP_CALIB
0x8078 -40 Embedded Data in the file is encrypted with a | Verify the programming file is generated
0x8079 Flash different AES key than the device. | from the latest version of
0x807A Memory Designer/FlashPro.
0x8087 Block MAC
0x8088 Failure.
0x8002 -42 Failed to File security settings do not match | Provide a programming file with security
0x8003 verify device. setting that match the security settings
security programmed into the device.
settings.
0x8093 -42 Failed to Device eNVM/EFMB client JTAG | Verify the device is programmed with the
verify protection settings are not correct eNVM/EFMB client JTAG
eNVM/EFMB | programmed or are programmed | protection settings
client JTAG | with different settings
protection
settings
0x8004 -43 Failed to File checksum and design name | Verify the device is programmed with the
verify design | do not match the device. correct data and design.
information.
0x8049 -44 | Failed to The AES key in the file does not Provide a programming file with an AES
verify AES match the AES key in the device. [ key that matches the AES key
key. File does not contain an AES key [ programmed into the device.
and the device is secured with an
AES key.
0x8054 -45 Device Programming file was generated | Generate STAPL file with the latest
package with an older version of software | version of Designer/FlashPro; use the
does not latest version of FlashPro software.
match the
programmin
g file.
0x8033 -46 Embedded File contains no pass key or Provide a programming file with the
0x8038 Flash incorrect pass key but EFMB read | correct pass key.
0x803D Memory is secured with a pass key.
0x8042 Block X
0x8045 Read is
0x8046 protected by
0x8047 pass key. A
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Cod Message

0x8048 valid pass
key needs to
be provided.

0x8034 -46 Embedded File contains encrypted EFMB for | Regenerate security programming file
0x8039 Flash block X but the device encryption | with the proper AES key.

0x803E Memory is not enforced for EFMB block X.
0x8043 Block Program device security. Retry
(EFMB) programming with EFMB block X with
block X encrypted programming file.

Read is not
protected by
pass key.

EFMB
content is
not secure
after
encrypted
programmin
g.

Unable to
proceed with
encrypted
NVM
programmin
g.

0x8032 -47 Embedded The programming EFMB data is Provide a programming file with
0x8037 Flash not encrypted, but the device encrypted EFMB data.

0x803C Memory contains an AES key with
0x8041 Block encryption enforced.
(EFMB)
block X
encryption is
enforced. A
programmin
g file with
encrypted
EFMB data
needs to be
provided.

0x8031 -48 Embedded File contains no pass key or Provide a programming file with a
0x8036 Flash incorrect pass key, but device is passkey that matches the passkey
0x803B Memory secured with a pass key. programmed into the device.
0x8040 Block
(EFMB)
block X
Write is
protected by
pass key.
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Cod Message
e
A valid pass
key needs to
be provided.
0x8035 -49 Embedded File contains encrypted EFMB for | Regenerate security programming file
0x803A Flash block X, but the device encryption | with proper AES key.
0x803F Memory is not enforced for EFMB block X.
0x8044 Block Program device security. Retry
(EFMB) programming EFMB block X with
block X encrypted programming file.
Encryption is
not enforced.
Cannot
guarantee
valid AES
key present
in target
device.
Unable to
proceed with
Encrypted
EFMB
programmin
g.
0x801A -50 No backup No backup calibration copy has If master copy is still intact, rerun Action
calibration been made or the backup copy to create backup calibration copy.
data found has been corrupted
or backup Workaround: Disable optional procedure
calibration CHECK_AND_BACKUP_CALIB
data has
been
corrupted
8x804E -51 Failed to This version of the silicon does If programming the EFMB while the
access not support programming of the FPGA is active is not required, then use
Embedded Embedded Flash Memory Block actions PROGRAM_NVM or
Flash while the FPGA Array is active. VERIFY_NVM. Otherwise, use latest
Memory. revision of silicon.
(AFS600
only)
0x804F -52 Failed to This version of the silicon does If programming the EFMB while the
access not support programming of the FPGA is active is not required, then use
Embedded Embedded Flash Memory Block actions PROGRAM_NVM or
Flash while the FPGA Array is active. VERIFY_NVM. Otherwise, use latest
Memory. revision of silicon.
(AFS1500
only)
0x8050 -53 Failed to This version of the silicon does If programming the EFMB while the
access not support programming block 3 | FPGA is active is not required, then use
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Cod Message
e
Embedded of the EFMBs while the FPGA actions PROGRAM_NVM or
Flash Array is active. VERIFY_NVM. Otherwise, use EFMB
Memory. blocks 0, 1, or 2, but do not use block 3.
(AFS1500
only)
0x8051 -54 | Failed to FPGA Array is accessing the If programming the EFMB while the
access target EFMB block while FPGA is active is not required, then use
Embedded attempting programming. actions PROGRAM_NVM or
Flash VERIFY_NVM. Otherwise, check the
Memory. NVM reset signal is stuck in FPGA design or use a different EFMB
design. block that is not being accessed. Check if
target EFMB block logic is tied to reset.
Unstable VCC
Monitor related power supplies that cause
MSS Clock is disabled during the issue during programming; check for
programming. transients outside of Microsemi
specifications. See your device datasheet
MSS Clock is not properly routed | for more information on transient
to the correct pin. specifications.
Verify that the NVM reset signal in the
design is not stuck.
Verify the MSS clock is enabled during
programming.
If the MSS clock is defined as an external
I/0, then verify that it is properly routed to
the correct pin.
0x808A -55 Failed to Programming file generated with | Generate STAPL file with the latest
0x8094 read an older version of software version of Designer/FlashPro; use the
Embedded latest version of FlashPro software
Flash
Memory Try again at a slower TCK
Block
(EFMB) Inspect device using Device Debug
Contact Microsemi Technical Support
0x808B -55 Failed to Unstable VPUMP voltage level. Monitor related power supplies that cause
read the issue during programming; check for
Embedded Unstable VCC transients outside of Microsemi
Flash specifications. See your device datasheet
Memory Unstable VCC_OSC (Fusion only) | for more information on transient
Block specifications.
(EFMB) Unstable VCC_ROSC voltage
level (SmartFusion only) Monitor VJTAG during programming;
measure JTAG signals for noise or
Signal integrity issues on JTAG reflection.
pins
0x808C -55 Failed to Internal errror Contact Microsemi Technical Support
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ERROR_CODE Exit Exit Possible Cause Possible Solution
Cod Message
e
read
Embedded
Flash
Memory
Block
(EFMB)
0x8011 -56 Failed to Try reprogramming.
read
calibration Workaround: Disable optional procedure
data CHECK_AND_BACKUP_CALIB
0x8012 -56 Failed to Unstable VCC Monitor related power
read supplies that cause the
calibration Unstable VCC_NVM/VCC_OSC issue during
data (Fusion only) programming; check for
transients outside of
Unstable Microsemi
VCC_ENVM/VCC_ROSC voltage specifications. See
level (SmartFusion only) your device datasheet
for more information on
Signal integrity issues on JTAG transient specifications.
pins
Measure
JTAG voltages, noise,
and reflection.
Try reprogramming.
Workaround: Disable
optional backup
procedure
CHECK_BACKUP_CA
LIB
0x808D -57 | eNVM/EFMB | File contains no Pass Key and Provide a programming file with a Pass
0x8092 is protected | device is secured with a Pass Key | Key that matches the Pass Key
by a Pass programmed into the device
Key; you Pass Key in the file does not
must provide | match device
a valid Pass
Key

SmartFusion, IGLOO, ProASIC3 and FusionDevice Exit Codes for
pre-v8.6 Software

The table below lists exit codes for SmartFusion, IGLOO, ProASIC3 and Fusion devices in pre-v8.6 software
only. This includes v8.5 SP2, v8.5 SP1, v8.5, etc. See the Device Exit Codes for Software v8.6 and Above
help topic for exit codes for older versions.

Note: Exit codes with positive integers are reserved for current and future standard EXIT codes of the

STAPL standard. Exit codes with negative integers are reserved for vendor-specific EXIT codes.
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Table 6 - Exit Codes for SmartFusion, IGLOO, ProASIC3 and Fusion Family Devices in pre-v8.6 Software

Exit
Code

Exit Message

Possible Cause

Possible Solution

Passed (no error).

A physical chain does not
match the expected set up
from the STAPL file.

Also known as Checking
Chain Error.

Physical chain configuration has been
altered. Something has become
disconnected in the chain.

The specific IR length of non-Microsemi
devices may be incorrect.

The order of the specified chain may be
incorrect.

Failed to enter
programming mode.

Unstable VPUMP voltage level.
Signal integrity issues on JTAG pins.

Older software or programming file used.

Monitor VPUMP voltage during
programming

Measure JTAG voltages, noise, and
reflection.

Generate STAPL file with the latest version
of Designer/FlashPro.
Use latest version of FlashPro software.

Failed to verify IDCODE.

Signal integrity issues on JTAG pins.

Measure JTAG pins, noise and reflection.

Failed Erase Operation.

Signal integrity issues on JTAG pins.

Monitor VPUMP voltage during
programming.

Measure JTAG voltages, noise, and
reflection.

10

Failed to program FPGA
array at row ",
rowNumber,"."

Signal integrity issues on JTAG pins.

Monitor VPUMP voltage during
programming.

Measure JTAG voltages, noise, or
reflection.

10

Failed to enable FPGA
Array.

Signal integrity issues on JTAG pins.

Monitor VPUMP voltage during
programming.

Measure JTAG voltages, noise, or
reflection.

10

Failed to program
FlashROM.

Signal integrity issues on JTAG pins.

Monitor VPUMP voltage during
programming.

Measure JTAG voltages, noise, and
reflection.

11

Verify 0 failed at
row",rowNumber,"."
Verify 1 failed at

row",rowNumber,".
Failed to verify FlashROM

at row",from rowNumber-1.

Device is programmed with a different
design.

Signal integrity issues on JTAG pins.

Run VERIFY_DEVICE_INFO to verify the
device is programmed with the correct
data/design.

Monitor VPUMP voltage during
programming.

Measure JTAG voltages, noise and
reflection .

14

Failed to program Silicon
Signature.

Signal integrity issues on JTAG pins.

Monitor VPUMP voltage during
programming.
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Exit Exit Message Possible Cause Possible Solution
Code
Failed to program security Measure JTAG voltages, noise, and
lock settings. reflection.
-18 Failed to authenticate the | Incorrect AES key. Generate a programming file with the
encrypted data. correct AES key.
Signal integrity issues on JTAG pins.
Measure JTAG voltages, noise and
reflection
-20 Failed to verify FlashROM | Device is programmed with a different Program with the correct data/design.
at row ", design.
FRomRowNumber-1. Monitor VPUMP level during programming.
Signal integrity issues on JTAG pins. Measure JTAG pins and noise or reflection.
-22 Failed to program pass Unstable VPUMP voltage level. Monitor VPUMP voltage during
key. programming.
Signal integrity issues on JTAG pins.
Measure JTAG voltages, noise, and
reflection.
-23 Failed to program AES Unstable VPUMP voltage level. Monitor VPUMP voltage during
key. programming.
Signal integrity issues on JTAG pins.
Measure JTAG pins and noise or
reflection.
-24 Failed to program UROW. | Unstable VPUMP voltage level. Monitor VPUMP voltage during
programming.
Signal integrity issues on JTAG pins.
Measure JTAG voltages, noise, and
reflection.
Make sure you mounted 0.01iF and 0.33iF
caps on Vpump (close to the pin).
-25 Failed to enter Signal integrity issues on JTAG pins. Measure JTAG voltages, noise, and
programming mode reflection.
-26 Failed to enter Signal integrity issues on JTAG pins. Measure JTAG voltages, noise, and
programming mode reflection.
-27 FlashROM Write/Erase is | File contains no passkey and device is Provide a programming file with a passkey
protected by the passkey. [ secured with a passkey. that matches the passkey programmed into
A valid passkey needs to Passkey in the file does not match device. | the device.
be provided.
-28 FPGA Array Write/Erase is | File contains no passkey and device is Provide a programming file with a passkey
protected by the passkey. [ secured with a passkey. that matches the passkey programmed into
A valid pass key needs to Passkey in the file does not match device. | the device.
be provided.
-29 FlashROM Read is File contains no passkey and device is Provide a programming file with a pass key
protected by passkey. secured with a passkey. that matches the passkey programmed into
A valid passkey needs to Passkey in the file does not match device. | the device
be provided.
58 FlashPro Express User's Guide




NOTE: Links and cross-references in this PDF file may point to external files and generate an error
when clicked. View the online help included with software to enable all linked content.

& Microsemi

SmartFusion, IGLOO, ProASIC3 and FusionDevice Exit Codes for pre-v8.6 Software

Exit
Code

Exit Message

Possible Cause

Possible Solution

FPGA Array verification is
protected by a passkey.
A valid passkey needs to
be provided.

File contains no passkey and device is
secured with a passkey.
Passkey in the file does not match device.

Provide a programming file with a passkey
that matches the passkey programmed into
the device.

Failed to verify AES key.

AES key in the file does not match the
device.

Unstable JTAG/VPUMP voltage level.

Provide a programming file with an AES
key that matches the AES key programmed
into the device.

Monitor VPUMP/VJTAG voltage during
programming.

Measure JTAG voltages, noise, and
reflection.

Failed to verify IDCODE.
Target is an M7 device

File is not for M7, but target device is an
M7.

Signal integrity issues on JTAG pins.

Check that the target device is M7 enabled.
Make sure programming file generated is
for M7 enabled device.

Measure JTAG pins , noise, and reflection.

Failed to verify IDCODE.
Target is an M1 device

File is not for M1, but target device is an
M1 device.

Signal integrity issues on JTAG pins.

Check that the target device is M1 enabled.
Make sure programming file generated is
for M1 enabled device.

Measure JTAG pins, noise, and reflection.

Failed to verify IDCODE.
Core enabled device
detected

File is not for target device.

Signal integrity issues on JTAG pins

Check the target device. Make sure
programming file generated for target
device.

Measure JTAG voltages, noise, and
reflection.

Failed to verify IDCODE.
The target is not an M7
device

File is for M7, but target device is not M7.

Signal integrity issues on JTAG pins.

Check that the target device is not M7
enabled.

Make sure programming file generated is
for non M7 enabled device.

Measure JTAG voltages, noise, and
reflection.

Failed to verify IDCODE.
The target is not an M1
device

File is for M1, but target device is not an
M1 device.

Signal integrity issues on JTAG pins.

Check that the target device is not M1
enabled.

Make sure programming file generated is
for non M1 enabled device.

Measure JTAG voltages, noise and
reflection.

FPGA Array encryption is
enforced. A programming
file with encrypted FPGA
array data needs to be

File contains unencrypted array data, but
device contains AES key.

Provide a programming file with an
encrypted FPGA Array data.
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Code
provided.
-34 FlashROM encryption is File contains unencrypted FlashROM data, | Provide a programming file with an
enforced. A programming | but the device contains an AES key. encrypted FlashROM data.
file with encrypted
FlashROM data needs to
be provided.
-35 Failed to match pass key. | Pass key in file does not match pass key in | Provide a programming file with a pass key
device. that matches the pass key programmed
into the device.
-36 FlashROM Encryption is File contains encrypted FlashROM, but Regenerate security programming file with
not enforced. device encryption is not enforced for proper AES key.
FlashROM
Cannot guarantee valid Program device security.
AES key present in target
device. Retry programming FlashROM with
encrypted programming file.
Unable to proceed with
Encrypted FlashROM
programming.
-37 FPGA Array Encryption is | File contains encrypted FPGA Array, but Regenerate security programming file with
not enforced. the device encryption is not enforced for proper AES key.
FPGA Array.
Cannot guarantee valid Program device security.
AES key present in target
device. Retry programming FPGA Array with
encrypted programming file.
Unable to proceed with
Encrypted FPGA Array
verification.
-38 Failed to program pass Unstable VPUMP voltage level. Monitor VPUMP voltage during
key. programming.
Signal integrity issues on JTAG pins.
Bad device. Measure JTAG pins and noise or
reflection.
-39 Failed to verify Embedded | Device is programmed with a different Verify the device is programmed with the
Flash Memory Block design. correct data/design.
(EFMB). Signal integrity issues on JTAG pins.
Monitor VPUMP voltage during
The EFMB data was modified through user | programming.
FPGA design after programming; this could | Measure JTAG pins and noise or
occur during standalone verify. reflection.
The target EFMB block is locked with Run DEVICE_INFO to confirm if the target
FlashLock when running ACTION EFMB block is locked with FlashLock (pass
PROGRAM_NVM_ACTIVE_ARRAY or key). If the target EFMB block is locked,
VERIFY_NVM_ACTIVE_ARRAY. then you must unlock it by erasing the
security and then reprogramming with the
desired security settings. After unlocking
the target EFMB block attempt to rerun the
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Exit
Code

Exit Message

Possible Cause

Possible Solution

target ACTION.

Embedded Flash Memory
Block MAC Failure.

Data in the file is encrypted with a different
AES key than the device.

Verify the programming file is generated
from the latest version of
Designer/FlashPro.

Error programming
Embedded Flash Memory
Block. (EFMB)

Signal integrity issues on JTAG pins.

Measure JTAG pins and noise or reflection.

Failed to verify security
settings.

File security settings do not match device.

Provide a programming file with security
setting that match the security settings
programmed into the device.

Failed to verify design
information.

File checksum and design name do not
match the device.

Verify the device is programmed with the
correct data and design.

Failed to verify AES key.

The AES key in the file does not match the
AES key in the device.

File does not contain an AES key and the
device is secured with an AES key.

Provide a programming file with an AES
key that matches the AES key programmed
into the device.

Device package does not
match the programming
file.

Embedded Flash Memory
Block X Read is protected
by pass key. A valid pass
key needs to be provided.

File contains no pass key or incorrect pass
key but EFMB read is secured with a pass
key.

Provide a programming file with the correct
pass key.

Embedded Flash Memory
Block, block X encryption
is enforced. A
programming file with
encrypted EFMB data
needs to be provided.

The programming EFMB data is not
encrypted, but the device contains an AES
key with encryption enforced.

Provide a programming file with encrypted
EFMB data.

Embedded Flash Memory
Block (EFMB) block X
Write is protected by pass
key.

A valid pass key needs to
be provided.

File contains no pass key or incorrect pass
key, but device is secured with a pass key.

Provide a programming file with a passkey
that matches the passkey programmed into
the device.

Embedded Flash Memory
Block (EFMB) block X

Encryption is not enforced.

Cannot guarantee valid
AES key present in target
device.

Unable to proceed with

File contains encrypted EFMB for block X,
but the device encryption is not enforced
for EFMB block X.

Regenerate security programming file with
proper AES key.

Program device security. Retry
programming EFMB block X with encrypted
programming file.
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Exit Exit Message Possible Cause Possible Solution

Code
Encrypted EFMB
programming.

-51 Failed to access This version of the silicon does not support | If programming the EFMB while the FPGA
Embedded Flash Memory. | programming of the Embedded Flash is active is not required, then use actions
(AFS600 only) Memory Block while the FPGA Array is PROGRAM_NVM or VERIFY_NVM.

active. Otherwise, use latest revision of silicon.

-52 Failed to access This version of the silicon does not support | If programming the EFMB while the FPGA
Embedded Flash Memory. | programming of the Embedded Flash is active is not required, then use actions
(AFS1500 only) Memory Block while the FPGA Array is PROGRAM_NVM or VERIFY_NVM.

active. Otherwise, use latest revision of silicon.

-53 Failed to access This version of the silicon does not support | If programming the EFMB while the FPGA
Embedded Flash Memory. | programming block 3 of the EFMBs while is active is not required, then use actions
(AFS1500 only) the FPGA Array is active. PROGRAM_NVM or VERIFY_NVM.

Otherwise, use EFMB blocks 0, 1, or 2, but
do not use block 3.
-54 Failed to access FPGA Array is accessing the target EFMB | If programming the EFMB while the FPGA

Embedded Flash Memory.

block while attempting programming.

NVM reset signal is stuck in design.

is active is not required, then use actions
PROGRAM_NVM or VERIFY_NVM.
Otherwise, check the FPGA design or use
a different EFMB block that is not being
accessed. Check if target EFMB block logic
is tied to reset.

Verify that the NVM reset signal in the
design is not stuck.

ProASICerLus Exit Codes

The table below lists the exit codes for ProASIC

PLUS Jevices.

Table 7 - ProASIC " Family Devices Exit Codes

Exit Code Exit Message Possible Cause Possible Solution
0 This message means
passed. This does not
indicate an error.
1 A physical chain does not | Physical chain configuration has
match the expected set up | been altered. Something has
from the STAPL file. become disconnected in the chain.
Also known as Checking The specific IR length of non-
Chain Error. Microsemi devices may be
incorrect.
The order of the specified chain
may be incorrect.
2 There is a reading device | The device either does not have a Check the device ID.
ID failure. valid device ID or the data cannot
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Exit Code

Exit Message

Possible Cause

Possible Solution

be read correctly.

This occurs when using
ProASIC™"® devices.

Connect was set up for a ProASIC
device and the device is actually
ProASIC™"S,

Set up for a ProASIC™™"® device.

Programming set up
problem. Also known as
Entering ISP Failure.

The A500K device senses the
VDDL power supply as being on.

Power the VDDL down during
programming. Check the device has
the correct voltages on VDDP, VDDL,
VPP, and VPN.

The IDCODE of the target
device does not match the
expected value in the
STAPL file. Thisis a

JEDEC standard message.

The device targeted in the STAPL
file does not match the device being
programmed.

User selected wrong device.

Device TRST pin is grounded.
Noise or reflections on one or more
of the JTAG pins caused by the IR
Bits reading it back incorrectly.

Choose the correct STAPL file and
select the correct device.

Measure JTAG pins and noise or
reflection. TRST should be floating or
tied high.

Cut down the extra length of ground
connection.

Unknown algorithm: alg=x,
prev=x Invalid data read
from device

This occurs with current STAPL files
when the revision written into the
factory row is not rev 1 for
ProASICPLUS devices. The STAPL
files from last year may "exit 7" with
newer devices or the older revision
may cause this failure if the STAPL
file used is from latest version.

This error can also occur if the
programmer has trouble reading the
factory row due to signal noise,
crosstalk, or reflections on the JTAG
signal and clock lines.

It can occur if you program an -F
ProASICPLUS device with an old
STAPL file.

This error occurs if you connected
VPP and VPN the wrong way.

It occurs if there are no bypass
Caps on VPP VPN, which damaged
the device.

This error may occur if your power
supply cannot source the correct
current for programming.

Re-generate STAPL file from
Designer 6.1 SP1.

Double check VPP and VPN
connections.

Make sure VPP and VPN have
correct bypass caps.

Make sure that your power supply
can deliver the correct current during
programming.

FPGA failed during the
erase operation.

The device is secured, and the
corresponding STAPL file is not
loaded.

The device has been permanently
secured and cannot be unlocked.

Load the correct STAPL file.

11

FPGA failed verify

The device is secured and the
corresponding STAPL file is not
loaded.

You used the Libero IDE software

Load the correct STAPL file.

Use later software versions —at least
Libero v2.3 SP1 and Designer R1-
2003 SP1.
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Exit Code

Exit Message

Possible Cause

Possible Solution

v2.3 or earlier or the Designer R1-
2003 software or earlier to generate
the STAPL file.

VPN caps were soldered in the
wrong polarity.

Double-check the VPN bypass caps
polarity.

12

Security is enabled.

The device is secured and the
wrong key/STAPL file was entered.
The device is damaged.

The verification was interrupted and
therefore fails, causing the software
to think the device is secure.

14

Program security failure.

15

This is a factory Calibration
Data CRC error.

During program, erase, or verify,
you must read back Calibration
Data from the FPGA. The data
contains a CRC. You use the CRC
to ensure the data is not
corrupted/wrong.

Device is damaged.

Noise on the FTAL signals causes
the programmer to read back wrong
data.

17

The device has been
secured. Write-security is
enabled.

The device is secured and the
wrong key or STAPL file was
entered.

The device is damaged.

Load the correct STAPL file.

Failed to access
Embedded Flash Memory

Analog power supplies (Vccl5A,
Vce33A, GNDAQ and GNDA) are
not connected.

Connect the analog power supplies
(Vccl5A, Vee33A, GNDAQ and
GNDA)

Unexpected RCK detected.

Noise on the RCK signal.

You connected a CLK source to the
RCK signal.

The polarized bypass capacitors on
VPP or VPN are reversed-biased
and are affecting the programmer’s
VPP or VPN output voltage. This
causes programming to fail. Several
FlashPros are programming at the
same time and are too close to each
other.

Programmer not properly installed
by Admin.

Disconnect the RCK and make sure
TCK has a clean signal.

Separate FlashPros away from each
other while they are programming
Internal ISP.

Connect programmer as an Admin in
FlashPro.

Calibration data parity
error.

Device is damaged.

Replace the device.

Null

Several FlashPros are programming
at the same time and are too close
to each other.
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Exit Code

Exit Message

Possible Cause

Possible Solution

FlashPro connects to PC parallel
port through a dongle key.

Data length mismatch when
performing DRSCAN on STAPL file.

Cable to target is not
connected properly.

When the Analyze command is
executed, the FlashPro looks for
target devices. If the cable
connection is wrong, FlashPro
assumes that nothing is connected
at all.

Confirm the connection between the
header to the device. If the board
supplies the power to the device,
make sure the voltage level is correct.

Chain integrity test failed:
XX

The connection between the
FlashPro programmer and the
device is broken.

The programmer cable might not be
securely inserted into the header.
The header is not connected to the
JTAG pins of the FPGA correctly.
The configuration setting
(ProASIC/ProASICPLUS) does not
match the target device.

Noise or reflections on the JTAG
pins has caused communication
between the programmer and the
device to fail.

A dongle is plugged in between the
PC parallel port and the FlashPro
parallel port cable.

Secure the connections.

Check the JTAG pins for signal
activity.

Check for broken TDO, TMS, and
TCK pins.

After checking all type of connections
if the failure exists, you may need to
replace the first device (the devices
closest to the TDO of the
programming header) in the chain.
Remove the dongle.

Could not connect to
programmer on port Ip1 or
parallel port device does
not support IEEE-1284
negotiation protocol

The remote device does not
respond to the negotiation protocol,
for a variety of reasons.

Make sure the port is connected.
Make sure the connected device is a
FlashPro/Lite programmer.

Turn the programmer on.

Check parallel port setting in BIOS.
Make sure that there are no dongles
in between the parallel port and the
FlashPro connection.

Try another parallel cable, the parallel
cable might be defective.

Check to see if the programmer is
damaged.

Make sure the FlashPro Lite has
power. The FlashPro Lite is powered
from the target board through the vdd
pin of the programming header.

Make sure the Vdd pin is connected
and the target board is powered up.
Secure the connection between the
cable connector and the programming
header.

Before you program any devices, you
should run the self-diagnostic test.
The diagnostic software can be found
on the Microsemi web site. If the test
fails, please contact Microsemi
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Exit Code

Exit Message

Possible Cause

Possible Solution

Customer Technical Support at
tech@Microsemi.com for credit and
replacement.

Note: The Self-test is only available
for FlashPro, not FlashPro Lite.

External voltage detected
on <Supply>

The voltage supply for the FPGA is
driven by another source (board,
external power-supply), but the user
forgot to turn off the supply in the
Connect menu.

Set appropriate options in the
Connect menu.

VDPP Disconnected.

There is no Vddp voltage supply to
the FPGA.

You accidentally turned off the Vddp
supply in the Connect menu.

The Vddp supply on the board is not
functioning.

Check the Vddp supply on the board
for appropriate voltages and correct
the Connect menu.

More than one unidentified device.

If you want to perform an
operation on the ProASIC
device, the rest of the
devices in the chain must
be in bypass mode.

To put devices in bypass
mode, select Configuration
> Chain Parameter (or click
the Chain Parameter
button in the Single STAPL
Configuration window),
then set the Pre IR, Pre
DR, Post IR or Post DR.

STAPL settings of Pre IR, Pre DR,
Post IR, and Post DR do not match
the chain configuration.

One or more of the devices in the
chain is damaged and the ID CODE
cannot be read back.

Make sure you have set Pre IR, Pre
DR, Post IR, and Post DR to match
the chain configuration. If you are still
experiencing the failure, it is likely that
the device's ID CODE cannot be read
and you need to replace the device.

Cannot find the
programmer with ID xxx

The programmer is removed from
the PC.

Delete programmer (or reconnect
programmer) and select the Refresh
Programmer button. See Connecting
Programmers for more information.

Fatal Error: Please check
programmer set up.

Software cannot resolve the error
encountered in the programmer.

Save the project file, restart the
software, and power cycle the
programmer.

External voltage xxx mV is
detected on xxx.

You have specified the programmer
to drive the xxx but external xxx is
detected.

Deselect the xxx in the
programmer setting.

Executing action xxx failed.

The STAPL runtime failed.

Executing action xxx with
serial index/action xx
failed.

The STAPL runtime failed.

No Vpump voltage source

Select the Vpump in the Programmer
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Exit Code

Exit Message

Possible Cause

Possible Solution

is detected.

setting. Make sure the external
Vpump is properly turned on.

Vpump short detected.

Use a different programmer. If the
problem persists, check the board
layout.

xxx Mhz TCK frequency in
this STAPL file is not
supported by the FlashPro
Lite detected. It supports
only 4 MHz TCK
frequency.

Check FlashPro Lite version being
used. Use FlashPro Lite Rev C or
modify the STAPL file to 4 MHz.

xxx Mhz TCK frequency in
this STAPL file is not
supported by the FlashPro
Lite RevC detected. It
supports only 1, 2 or 4 Mhz
TCK frequency.

Modify STAPL file to 1, 2, or 4 MHz.

Cannot find the serial
Index/Action xxx in STAPL
file.

Mismatch between STAPL file and

the Index/Action selection.

Make sure the STAPL file was not
overwritten. Save the project with
updated serial/action selection.

Duplicated serial
Index/Action xxx was
removed.

Mismatch between STAPL file and

the Index/Action selection.

Make sure the STAPL file was not
overwritten. Save the project with
updated serial/action selection.

Using local backup copy
XXX

Cannot find original copy.

Check for available space on the disk.
Check that write permissions are
enabled.

FlashPro cannot rename
the programmer/device
with an existing name.

Name is already in use.

Create a new hame.

FlashPro cannot rename
the programmer/device
with an invalid character.

Invalid character used in
programmer/device name.

Do not use invalid characters.

Automatic check for
updates.

FlashPro can check the Microsemi
website to find if an updated version
of the software is available. If you
would like to have FlashPro
automatically check for software
updates, choose Preferences from
the File menu. From the Updates tab,
you can choose your automatic
software update settings. You can
also select Software Updates from
the Help menu for updates to the
FlashPro software.

FlashPro parse error.

FlashPro software failed to parse

the file.
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Exit Code Exit Message Possible Cause Possible Solution
FlashPro does not support | STAPL file not allowed. Use a STAPL file for your device that
STAPL files for xxx. is supported by FlashPro.
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DC Characteristics for FlashPro5/4/3/3X

Electrical Parameters

DC Characteristics for FlashPro5/4/3/3X

Note: The target board must provide the VCC, VCCI, VPUMP, and VJTAG during programming. However,
if there is only one ProASIC3 device on the target board, the FlashPro5/4/3/3X can provide the
VPUMP power supply via the USB port.

Note: The VJTAG signal is driven from a regulator internal to the FP4. The regulator can source up to
100mA on the VIJTAG pin.

Table 8 - DC Characteristic for FlashPro5/4/3/3X

Description Symbol Min Max Unit
Input low voltage, TDO VIL -0.5 0.35*VJTAG |V
Input high voltage, TDO VIH 0.65*VJTAG | 3.6 \%
Input current, TDO lIL, IIH | -20 +20 mA
Input capacitance, TDO 40 pF
Output voltage, VPUMP, VPP +3.0 +3.6 \Y
operating
Output current, VPUMP IPP 250 mA
VJITAG = 1.5V
Output low voltage, TCK, TMS, | VOL 0.0 0.2 \Y
TDI, 100uA load
Output low voltage, TCK, TMS, |VOL 0.0 0.30*VJTAG |V
TDI, 4mA load
Output high voltage, TCK, TMS, |V VJIJTAG-0.2 [VJITAG \Y
TDI, 100pA load
Output high voltage, TCK, TMS, | VOH 0.70*VJITAG | VITAG \%
TDI, 4mA load
Output current, TCK, TMS, TDI | IOL, -4 +4 mA

IOH

VJITAG = 1.8V
Output low voltage, TCK, TMS, | VOL 0.0 0.2 \%
TDI, 100pA load
Output low voltage, TCK, TMS, | VOL 0.0 0.3 \Y
TDI, 6mA load
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Description Symbol Min Max Unit

Output high voltage, TCK, TMS, | VOH VITAG-0.2 |VJITAG \%

TDI, 100pA load

Output high voltage, TCK, TMS, | VOH 1.25 VITAG \%

TDI, 6mA load

Output current, TCK, TMS, TDI | IOL, -6 +6 mA
IOH

VJITAG = 2.5V

Output low voltage, TCK, TMS, | VOL 0.0 0.2 \%

TDI, 100pA load

Output low voltage, TCK, TMS, | VOL 0.0 0.6 \Y

TDI, 8mA load

Output high voltage, TCK, TMS, | VOH VJIJTAG-0.2 | VJITAG \%

TDI, 100pA load

Output high voltage, TCK, TMS, | VOH 1.8 VITAG \Y

TDI, 8mA load

Output current, TCK, TMS, TDI | IOL, -8 +8 mA
IOH

VJTAG = 3.3V

Output low voltage, TCK, TMS, | VOL 0.0 0.2 \%

TDI, 100uA load

Output low voltage, TCK, TMS, | VOL 0.6 \%

TDI, 8mA load

Output high voltage, TCK, TMS, | VOH VITAG-0.2 |VJITAG \%

TDI, 100uA load

Output high voltage, TCK, TMS, | VOH 2.4 VITAG \%

TDI, 8mA load

Output current, TCK, TMS, TDI | IOL, -8 +8 mA
IOH

DC Characteristics for FlashPro Lite

Table 9 - DC Characteristic for FlashPro Lite

Description Symbol Min Max | Unit
Input low voltage, TDO VIL -0.5 0.7 \%
Input high voltage, TDO VIH 1.7 5.0 \%
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Description Symbol Min Max | Unit
Input current, TDO 1L, 1IH -10 +10 UA
Input capacitance, TDO 40 pF
Input voltage, VDD, operating (see note) +2.3 [+3.5 \%
Input voltage, VDD, power off -1.0 +1.0 \%
Input current, VDD VDD 500 mA
Output voltage, VPP, operating VPP +15.9 | +16.5 |V
Output voltage, VPN, operating VPN -13.8 | -134 | V
Output current, IPP IPP 0 35 mA
Output current, IPN IPN 0 -15 mA
Output low voltage, TCK, TMS, TDI, 100uA load VOL 0.0 0.2 \%
Output low voltage, TCK, TMS, TDI, 1mA load VOL 0.0 0.5 \Y
Output low voltage, TCK, TMS, TDI, 2mA load VOL 0.0 0.8 \Y
Output high voltage, TCK, TMS, TDI, 100uA load VOH 2.1 25 \%
Output high voltage, TCK, TMS, TDI, 1mA load VOH 1.9 2.5 \Y
Output high voltage, TCK, TMS, TDI, 2mA load VOH 1.6 2.5 \Y
Output current, TCK, TMS, TDI, nTRST IOL, IOH | -2 +2 mA

& Microsemi

DC Characteristics for FlashPro

Note: Up to 3.5 V can be supplied to the FlashPro Lite on the VDD pin. However, if the VDD supply for the
FlashPro is also connected to the APA VDD supply, the voltage for the VDD pin cannot exceed 2.7 V.

DC Characteristics for FlashPro

Table 10 - DC Characteristic for FlashPro

Description Symbol Min Max Unit
Input low voltage, TDO VIL -0.5 0.30* \%
VDDP
Input high voltage, TDO VIH 0.70 * 55 \%
VDDP
Input current, TDO IIL, 1IH -10 +10 UA
Input voltage, VDDP, VDDL 0 5.25 \Y
Input voltage, VPP 0 21.0 \%
Input voltage, VPN -21.0 \%
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Description Symbol Min Max Unit
Input current, VDDP, VDDL, VPN, VP IVCC 5.0 mA
Output voltage range, VDDP VDDP 15 3.3 \%
Output voltage range, VPP VPP 15.0 18.0 \%
Output voltage range, VPN VPN -16.0 -12.0 \%
Output voltage resolution / Acccuracy 100/450 |mV
Output current, IDDP IDDP -135" +135 mA
Output current, IDDL IDDL -135t +135 mA
Output current, IPP IPP -2701% +270 mA
Output current, IPN IPN -270 +270" mA
Output low voltage, TCK, TMS, TDI, OUTO, | VOL 0.0 0.4 \%
NTRST
Output high voltage, TCK, TMS, TDI, OUTO, | VOH 0.85* +0.3 \Y
NTRST VDDP VDDP
Output current, TCK, TMS, TDI, OUTO, 0L, -12 +12 mA
NTRST IOH

Note: Note (1): When power supply mode is set to ABI_GROUND.

Note: * - If you want to power-up the device from the board power supply, clear the checkboxes for VDDL
and VDDP. VPP and VPN are required during programming only and are supplied by the FlashPro
programmer.

Note: (2) Microsemi does not have operating temperature information for the FlashPro programmer.
FlashPro is intended to be used as lab or production equipment and not tested at extreme
temperatures. All devices in the unit are commercial temp. FlashPro4 went through a burn-in cycle
operating at 100C for 250 hours during quality testing. This involved repeatedly powering the
programmers and then programming after the burn in; they are not actively programming during the
burn in.
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FlashPro4

Electrical Specifications

FlashPro4

The FlashPro4 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector
on the FlashPro4 unit is a 2x5, RA male Header connector, which is manufactured by AMP and has a
manufacturer’s part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use
the 10 pin right-angle header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro4 and use the 10
pin straight header, AMP P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version..

The signals on the pins of the FlashPro4 10-pin connector are shown in the figure below (extracted from
FlashPro4 product specification):

-~ TCK|1 2 |GND ~—
— TDO|3 4 |PROG_MODE ——
-— Tms[s 6 |VITAG —=—
- Veoump |7 8 |nTRST —
- TDI|9 10 |GND «—»w

Figure 17 - FlashPro4 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.
Table 11 - FlashPro4 Signal Description

Signal Description
VPUMP 3.3V Programming voltage
GND Signal reference
TCK JTAG clock
TDI JTAG data input to device
TDO JTAG data output from device
T™MS JTAG mode select
NTRST Programmable output pin may be set to off, toggle, low, or high level
VITAG Reference voltage from the target board
PROG_MODE | IGLOO v2 family - Used for switching from VCC 1.2V to 1.5V during
programming

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
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state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the “Drive TRST” flag will be required to force the
JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to
select this flag.

FlashPro3

The FlashPro3 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector
on the FlashPro3 unit is a 2x5, RA male Header connector, which is manufactured by AMP and has a
manufacturer’s part number of 103310-1. This is a standard 2x5, 0.1 pitch connector which is keyed. Use
the 10 pin right-angle header, AMP P/N 103310-1 (DigiKey P/N A26285-ND) for FlashPro5/4/3/3X and use
the 10 pin straight header, AMP P/N 103308-1 (DigiKey P/N A26267-ND) for the straight version.

The signals on the pins of the FlashPro3 10-pin connector are shown in the figure below (extracted from
FlashPro3 product specification):

-~ TCK| 2 |GND ~—
—  TDO|3z 4 |N/C

*—TMSES 6 |VITAG =—
- Voumn |7 8 |nTRST —m
- TDI|9 10 |GND <+——=

Figure 18 - FlashPro3 10-Pin Connector

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows a description of the signals.
Table 12 - FlashPro3 Signal Description

Signal Description

VPUMP [ 3.3V Programming voltage

GND Signal reference

TCK JTAG clock

TDI JTAG data input to device

TDO JTAG data output from device

T™MS JTAG mode select

NTRST | Programmable output pin may be set to off, toggle, low, or high level

VIJTAG [ Reference voltage from the target board

N/C Programmer does not connect to this pin
Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
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FlashPro Lite

will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the “Drive TRST” flag will be required to force the

JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to
select this flag.

FlashPro Lite

For FlashPro Lite, the existing 26-pin connector is shown in the figure below.

N/C|1 2 IN/C

N/C|3 4 IN/C
N/C|5 6 |Vep ——
-~ GND|7 8 |Ven —
- GNDJg 10 [SENSE -~
-— GND| 1 12 |TCK -
N/C| 13 14 |TDI -
N/C L15 16 |TDO -
-— GND17 18 |TMS —
-— GND[19 20 |OUTO/RCK ——
N/C |21 22 InTRST —
N/C |23 24 Voo e E—
N/C |25 26 Voo -—

Figure 19 - 26-pin Connector for FlashPro Lite

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The appropriate SAMTEC micro connector target cable for this is:

Samtec FFSD-13-D-12.00-01-N.

The 12 inch cable is specified. This is likely to be more than enough to connect to the board and reducing
the inductance will help compared with 18 inches, which is supplied by the default with FlashPro Lite.
See the table below for a description of the signals.

Table 13 - FlashPro Lite Signal Description

Signal Description
VDDP VDD supply for logic I/O pads
VDDL VDD supply for core
VPP Positive programming supply (+16.5V)
VPN Negative programming supply(-13.8V)
GND Signal reference
SENSE Input from target board to programmer to indicate connection to ground
TCK JTAG clock
TDI JTAG data input to device
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Signal Description

TDO JTAG data output from device

TMS JTAG mode select

NnTRST Programmable output pin may be set to off, toggle, low, or high level

RCK/OUTO | Programmable output pin may be set to off, toggle, low, or high level

N/C Programmer does not connect to this pin

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the "Drive TRST" flag will be required to force the
JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to
select this flag.

FlashPro

For FlashPro, you can use the same 26-pin target cable you used for FlashPro Lite, but the connections are
shown in the figure below.

-—  2.5V/3.3V[1 2 |Voor —_—
-—  2.5V/3.3V|3 4 |Voop .
-~  2.5V/3.3V|5 6 |Vee _—
- GND|7 8 [Ven —
-~ GNDJ 9 10 |SENSE -—
- GND| 11 12 |[TCK -

N/C| 13 14 |TDI -

N/C L 15 16 |[TDO -
-~ GNDN7 18 [TMS -
- GND|19 20 |RCK/OUTO —
-~ 2.5V 21 22 InTRST -
-— 2.5V |23 24 |Vooo E——
- 2.5V |25 26 Voo —

Figure 20 - 26-pin connections for FlashPro

Note: All ground pins must be connected. The rectangular shape shows connections on the programmer
itself. Arrows show current flow towards or from the rectangular programmer.

The table below shows the signal pin descriptions for FlashPro.
Table 14 - FlashPro Signal Description

Signal Description
VDDP VDD supply for logic I/O pads
VDDL VDD supply for core
VPP Positive programming supply (+16.5 V)
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Signal Description
VPN Negative programming supply (-13.8 V)
GND Signal reference
SENSE Input from target board to programmer to indicate connection to
ground
TCK JTAG clock
TDI JTAG data input to device
TDO JTAG data output from device
T™MS JTAG mode select
NTRST Programmable output pin may be set to off, toggle, low, or high
level
RCK/OUTO Programmable output pin may be set to off, toggle, low, or high
level
2.5V, 2.5V/3.3V, Programmer does not connect to these pins
N/C

& Microsemi
FlashPro 5/4/3/3X Characteristics

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied
to ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset
state by default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even
will not suddenly throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-
down resistor on TRST on your board, then enabling the "Drive TRST" flag will be required to force the
JTAG state-machine out of reset to permit programming to take place. With most boards, there is no need to

select this flag.

FlashPro 5/4/3/3X Characteristics

Table 15 - JTAG Switching Characteristics for FlashPro5/4/3/3X

Description Symbol Min | Max | Unit
Output delay from TCK to TDI, TMS TTCKTDI -2 2 ns
TDO setup time before TCK rising, VJITAG=3.3 TTDOTCK |12 ns
TDO setup time before TCK rising, VJITAG=1.5 TTDOTCK |14.5 ns
TDO hold time after TCK rising TTCKTDO |0 ns
TCK period TTCK 41.7 | 10667 |ns

FlashPro and FlashPro Lite Characteristics

The table below shows the JTAG switching characteristics for FlashPro and FlashPro Lite measured at the
programmer end of the JTAG cable.

FlashPro Express User's Guide
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Table 16 - JTAG Switching Characteristics for FlashPro and FlashPro Lite
Description Symbol Min [ Max [ Unit

Output delay from TCK falling to TDI, | TTCKTDI 2 |2 ns

TMS

TDO setup time before TCK rising TTDOTCK 5.0 ns

TDO hold time after TCK rising TTCKTDO | 0 ns

TCK period TTCK 40 (10240 |ns

lllustration of the JTAG Switching Characteristics

The figure below is an illustration of the JTAG switching characteristics.

X

WWW

TCK

TMS, TDI

N/
<+— [Tk B

Trewrto —=

TTDCTCHA"

Trokroo—
Figure 21 - JTAG Switching Characteristics
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FlashPro Express Reference

FlashPro Express Start Page

The FlashPro Express Start Page is the first page to show when the tool starts up. This page provides the
interface for loading a project into the tool by either navigating to the project location, or clicking on one of

the recently opened projects.

E FlashPro Express
File  Edit

Wiew Tools  Help

Open...

Recent Projects List

CihllsershptgatDesktoph38Flashprotderno_10_devices\derno_10_dewvices.pro
CillsershptgatDesktophS8Flashprottest_agfpitest.pro
Divhamdyatdermo_10_devicestdemo_10_devices.pra
CilifStand_Alone_FlashPro_Testinghparallel_prograrmingitest_agfphtest.pro
Divternphsdinentsdlnewpro

Lag

QErrors 1. Warnings 0Info

& Microsemi

(oo )

Figure 22 - FlashPro Express Start Page

FlashPro Express File Menu

Command

Function

Create Job Project from Programming
Job

New job project folder with programming job name will be created at the specified
location.

Load Job Project

Loads a job project into the tool by reading the information in user specified .pro file.
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Command Function

Close Job Project Closes the current job project

Save Job Project Saves the current job project

Set Log File Sets the location of the Log file to your specified location.

Export Log File Exports the Log file to your specified location.

Execute Script Runs your specified Tcl script.

Export Run Script Exports all commands run in this session to your specified path as a Tcl script

Exit Exits FlashPro Express

FlashPro Express Edit Menu

Command Function

Clear Log Window Clears the Log window

FlashPro Express View Menu

The View menu shows or hides the FlashPro Express GUI elements.

Command Function

Log Window Shows/hides the Log window

FlashPro Express Tools Menu

Command Function
Programmer Opens the Programmer Settings dialog box; enables you to set options for all types of supported
Settings Microsemi programmers
Run Runs the current Programming Action.
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FlashPro Express Help Menu

Command Function
Help Topics Opens the help
Microsemi Technical Opens the Microsemi technical support site.
Support
Microsemi Web Site Opens the Microsemi website in your default browser
User Guide Opens the FlashPro Express User Guide.
Check for Software Checks for software updates (works only if you are
Updates connected to the internet)
About FlashPro Express | Lists the FlashPro Express release information

FlashPro Express Log Window and Status Bar

FlashProExpress Log Window

The FlashPro Express log window shows status messages for user activity. Click on the appropriate tab
(Messages, Errors, Warning, Info) to filter messages by type.

e Use the right-click menu to copy text, clear the log, and scroll the log.
e Use the def variable LOG_WINDOW_BUFFER_SIZE to set the buffer size.
e Use the View menu to show or hide the Log window.

FlashProExpress Status Bar
The Status Bar at the bottom displays the status of the load project action.
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Contacting Microsemi

Microsemi SoC Products Group Headquarters

Microsemi Corporation is a supplier of innovative programmable logic solutions, including field-
programmable gate arrays (FPGAs) based on antifuse and flash technologies, high-performance intellectual
property (IP) cores, software development tools, and design services targeted for the high-speed
communications, application-specific integrated circuit (ASIC) replacement, and radiation-tolerant markets.

Address: Microsemi SoC Products Group
3870 North First Street
San Jose, CA 95134

Phone: 408-643-6000

See Also
Customer Service
Technical Support
Sales

Technical Support

Highly skilled engineers staff the Technical Support Center from 7:00 AM to 6:00 PM Pacific Time, Monday
through Friday.

Visit Tech Support Online

For 24-hour support resources, visit Microsemi Technical Support at
http://www.microsemi.com/fpga-soc/design-support/fpga-soc-support

Contacting Technical Support

Contact us with your technical questions via e-mail or by phone. When sending your request to us, please be sure to include

your full name, company name, email address, and telephone number.

E-mail (Worldwide): soc_tech@Microsemi.com
Telephone (In U.S.): (650) 318-4460
(800) 262-1060
Telephone (Outside the US): Contact a local sales office
See Also

Microsemi SoC Headquarters
Customer Service

Sales
Documentation feedback
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Customer Service

Customer Service

Contact Customer Service for order status, order expedites, return material authorizations (RMA), and first
article processing. For technical issues, contact Technical Support.

The Customer Service phone number is +1 650 318 2470.
Customer Service email: customer.service@microsemi.com

Regulatory and Compliance Information

EU Declaration of Conformity:

This product complies to Directive 2011/65/EU of the European Parliament and of the Council of 8 June
2011 on the restriction of the use of certain hazardous substances in electrical and electronic equipment.

To view the Declaration of Conformity in English:
http://www.microsemi.com/index.php?option=com_docman&task=doc_download&gid=131772

Non-English:
http://www.microsemi.com/index.php?option=com_docman&task=doc_download&gid=131748

Markings:

c € This product complies with 2004/108/EC, Electromagnetic Compatibility (EMC) Directive
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Product Support

The Microsemi SoC Products Group backs its products with various support services including a Customer
Technical Support Center and Non-Technical Customer Service. This appendix contains information about
contacting the SoC Products Group and using these support services.

Contacting the Customer Technical Support Center

Microsemi staffs its Customer Technical Support Center with highly skilled engineers who can help answer
your hardware, software, and design questions. The Customer Technical Support Center spends a great
deal of time creating application notes and answers to FAQs. So, before you contact us, please visit our
online resources. It is very likely we have already answered your questions.

Technical Support

Microsemi customers can receive technical support on Microsemi SoC products by calling Technical
Support Hotline anytime Monday through Friday. Customers also have the option to interactively submit and
track cases online at My Cases or submit questions through email anytime during the week.

Web: www.actel.com/mycases

Phone (North America): 1.800.262.1060
Phone (International): +1 650.318.4460
Email: soc_tech@microsemi.com

ITAR Technical Support

Microsemi customers can receive ITAR technical support on Microsemi SoC products by calling ITAR
Technical Support Hotline: Monday through Friday, from 9 AM to 6 PM Pacific Time. Customers also have
the option to interactively submit and track cases online at My Cases or submit questions through email
anytime during the week.

Web: www.actel.com/mycases

Phone (North America): 1.888.988.ITAR
Phone (International): +1 650.318.4900
Email: soc_tech_itar@microsemi.com

Non-Technical Customer Service
Contact Customer Service for non-technical product support, such as product pricing, product upgrades,
update information, order status, and authorization.

Microsemi's customer service representatives are available Monday through Friday, from 8 AM to 5 PM
Pacific Time, to answer non-technical questions.

Phone: +1 650.318.2470

84 FlashPro Express User's Guide






Microsemi Corporation (Nasdag: MSCC) offers a comprehensive portfolio of semiconductor
and system solutions for communications, defense and security, aerospace, and industrial
markets. Products include high-performance and radiation-hardened analog mixed-signal
integrated circuits, FPGAs, SoCs, and ASICs; power management products; timing and
synchronization devices and precise time solutions, setting the world's standard for time; voice
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